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Typographic Conventions 
 
 
 

 
Type Style Description 

Example Words or characters quoted from the screen. These include field names, screen titles, 

pushbuttons labels, menu names, menu paths, and menu options. 

Textual cross-references to other documents. 

Example Emphasized words or expressions. 

EXAMPLE Technical names of system objects. These include report names, program names, 

transaction codes, table names, and key concepts of a programming language when they 

are surrounded by body text, for example, SELECT and INCLUDE. 

Example Output on the screen. This includes file and directory names and their paths, messages, 

names of variables and parameters, source text, and names of installation, upgrade and 

database tools. 

Example Exact user entry. These are words or characters that you enter in the system exactly as 

they appear in the documentation. 

<Example> Variable user entry. Angle brackets indicate that you replace these words and characters 

with appropriate entries to make entries in the system. 

EXAMPLE  Keys on the keyboard, for example, F2 or ENTER . 
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1 Introduction 

 
 

The Conditions for Safety Statements (CoSSta) is a functionality within the EH&S Expert Rule Editor. Conditions 

created in CoSSta are used in the Rule for Safety Statements rule set. During secondary data determination for a 

specification, this rule set determines which conclusive phrases should be transferred to the specification. By 

using this function, you can assign phrases to a substantial number of characteristics to fill out material safety 

data sheets (MSDS), or standard operating procedure (SOP) documents. 

You require the 3E EHS Regulatory Content in order to use CoSSta. For more information, see 3E EHS Regulatory 

Content. 

https://www.3eco.com/products-services/integrated-content-solutions-sap/integrated-content-sap-ehs-and-s4hana-product
https://www.3eco.com/products-services/integrated-content-solutions-sap/integrated-content-sap-ehs-and-s4hana-product
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2 Getting Started 

 
 

2.1 Choosing the Database 
 
 

Figure 1 - Choosing a Database 
 

First, you need to choose the database in which the conditions that you have created should be stored. Ensure the 

selected database is in a valid CoSSta access file format. The database should contain the following data: 

• Conditions 

• Supported characteristics for the conclusive phrases and facts. 

• Supported identification types 

• Supported predefined conditions 

• Assignment of customer-specific characteristics 

• Imported characteristics and phrases 

• Usage profiles 

 
Note 

You will need authorization to modify the database when using the CoSSta functionality. The 

CoSSta access file is provided in the SAP EHS Regulatory Content, Safety Data Sheets Authoring 

package. 

 

Recommendation 

We recommend that you use the CoSSta.mdb access file as it contains standard values, such 

as supported characteristics which are used in the Rule for Safety Statements. 

 

Recommendation 

We recommend that you save the CoSSta.mdb access file locally to avoid waiting times during 

data migration and property tree import. For performance reasons, we recommend you save the 

CoSSta.mdb access file on the EH&S Expert Server when determining secondary data. For 

more information, see Working with the EH&S Expert. 

To connect to a database, proceed as follows: 

1. Open the Rule Editor and choose Conditions for Safety Statements → Choose Database. 

2. Select the access file CoSSta.mdb and choose Done. 
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2.2 Importing Property Tree and Phrases 

 
The Property Tree for Safety Statements consists of two parts. These are: 

• CONCLUSION 

This defines the value assignments used in the List of Sections in the Initial Screen. The assigned 

characteristics are used as conclusive characteristics. This means that you can define conditions for 

each of these characteristics. The conclusive phrase is transferred to these characteristics. 

• FACTS 

This defines the value assignments and characteristics used in the property tree in the Edit Condition 

screen. The characteristics are used as facts. This means that you can use these to define condition 

parameters for your conditions. 

 
To import a property tree and phrases, proceed as follows: 

1. In the EHS system, start the substance workbench (transaction CG02) and choose the Property Tree for 

Safety Statements. 

Alternatively, you can change the parameter value of your user profile in the EHS system. In your EHS 

system, choose System → User Profile → Own Data. Select the Parameters tab and set the Parameter 

Value RULCOSSTA for the SET/GET Parameter ID ES6. 

Open the Rule Editor and load the property tree from the EHS system. Choose Tools → Property Tree → 

Reload From EH&S. 

 

Note 

You can only load the property tree from the EHS system if the Rule Editor is connected to the 

EHS system. If the Rule Editor is disconnected, choose Tools → Connect to System to connect to 

the EHS system. 

 

Recommendation 

We recommend that you save the property tree locally after you have loaded it to the Rule 

Editor. In this way, the property tree does not need to be downloaded automatically each time 

you start CoSSta. 

Carry out the following: 

1. Choose Tools → Property Tree → Save locally 

2. Choose Tools → Options → General: Offline 

2. In the Rule Editor, choose Conditions for Safety Statements → Import Property Tree. The import can take 

up to several minutes. 

 

Note 

You can select the property tree language by choosing Tools → Options → Property Tree → 

Language. 

 
Recommendation 

We recommend that you select English for the import of the property tree. 
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2.3 Configuration 

 
Before you are able to manage conditions, you have to configure the following functions: 

• Managing Phrases 

• Managing Usage Profiles 

• Editing Identification Types 

• Editing Customer-Specific Characteristics 
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3 Managing Conditions 

 
 

1. Conclusion: 

Here, you define the phrase which will be derived from the condition parameters with its usage. This will be 

transferred to the specification. You can select if an own value assignment instance should be created for the 

conclusive phrase in the characteristic in the specification. 

If you select a conclusive phrase, its sort sequence, weight of importance and group is displayed. These values 

can be edited in the Manage Phrases screen. 

The usage and the conclusive phrase are mandatory values. 

 

2. Condition Parameter: 

Here, you define the values for the condition parameter. 

All facts with their logical operator and expressions are displayed in the list. You can edit an existing fact by either 

double clicking it or selecting it and choosing  (Edit fact). Alternatively, you can use the menu path Condition → 

Edit Fact. 

You can delete an existing fact by selecting it and choosing  (Delete fact). Alternatively, you can use the menu 

path Condition → Delete Fact. 

You can define if the condition parameter is always applicable by flagging the corresponding checkbox. Only facts 

with the logical operator NOT can be used in combination with this condition parameter. 

You can define if the condition parameter is applicable if no other condition applies by flagging the corresponding 

checkbox. Other facts are not permitted in combination with this condition parameter. 

 
3. Facts: 

The facts are displayed in a tree structure in the same way as the Property Tree for Safety Statements on the 

right of the screen. Here, you can add new facts to the Condition Parameter. 

To add a fact, expand the tree to the lowest level and select a characteristic. 
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Five fact types are available: 

 

• Fact Type: Phrase-Enabled  
 

Figure 2 - Fact Type – Phrase-Enabled 
 

You can assign several phrases as expressions to phrase-enabled facts. If you select several phrases, they are 

connected with the logical operator OR. Only one of the phrases needs to apply to verify the fact. 

In the Edit Expression screen, a list of all phrases assigned to the characteristic of the fact is displayed. 

Flag the checkbox to add one or several phrases to the fact. You can also select or deselect all phrases by 

selecting the column header of this column. 

You can search for a specific phrase by entering the search term and choosing  (Search). 

You can search by phrase key, code or text. 

You have to select at least one phrase to add the fact to the Condition Parameter. 

You can define the Logical Operator by making a selection from the dropdown list. 

Note 

You can change the sort sequence within the column by selecting the column header. 
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Unit of Measure 

 
 
 
 

• Fact Type: Numeric Value 
 

Figure 3 - Fact Type - Numeric Value 
 

In numeric facts you define number ranges for the condition parameter. 

You can add a Lower Limit with its operator and an Upper Limit with its operator by entering the values in the 

corresponding fields. You have to either select a Lower Limit with its operator or an Upper Limit with its operator 

to add the fact to the Condition Parameter. 

The Unit of Measure for the characteristic is also provided. This is the unit assigned to the characteristic in the 

EHS system. 

You can define the Logical Operator by making a selection from the dropdown list. 

 

• Fact Type: Identifier  
 

Figure 4 - Fact Type - Identifier 
 

This fact type provides the option to create a condition parameter based on the identification type in the 

specification. 

Example: If the specification has CAS number <1330-20-7> assigned. 

Enter a value for the Identifier. This field is mandatory. 

You can also add values with placeholders such as “100*” to create condition parameters. 

Example: If the specification has a CAS number assigned which starts with 100. 

You can define the Logical Operator by making a selection from the dropdown list. 
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• Fact Type: Specification 
 

Figure 5 - Fact Type - Specification 
 

This fact type provides the option to create a condition parameter based on the specification. 

Example: If the specification has the Specification key <SUB_XYLOL> assigned. 

This only makes sense if you add either placeholders in the specification value such as “D*” to find all specification 

which starts with a D, 

Enter a value for the specification. This field is mandatory. 

You can define the Logical Operator by making a selection from the dropdown list. 

 

• Fact Type: Predefined Conditions  
 

Figure 6- Fact Type – Predefined Condition 
 

Predefined condition is the combination of rules that are carried out in the Rule for Safety Statements. If the 

result of the predefined condition is equal to the entered value, the condition parameter applies. 

Select one value of the predefined value to add a predefined condition to the Condition Parameter. 

For more information on predefined conditions, see Predefined Conditions. 

You can define the Logical Operator by making a selection from the dropdown list. 
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3.1 Overview of Conditions 

 
All defined conditions for the characteristic which you selected in the List of Results are displayed here. 

 

Figure 7 - Overview of Conditions 
 

This provides you with an overview of all conditions, together with conclusive data for each characteristic. 

In this screen, you have the option to create new conditions, edit or copy existing ones, delete them. You can also 

set or remove the filter for found conditions. 

 
1. Create Condition: 

Create a new condition by choosing  (Create condition) or via Conditions for Safety Statements → Create 

Condition. You can edit the values for the new condition in the next screen. 

 
2. Copy Condition: 

Copy a condition by selecting it in the list of conditions and then choosing  (Copy condition). Alternatively, you 

can choose the menu path Conditions for Safety Statements → Copy Condition. 

 
3. Edit Condition: 

Edit a condition by selecting it in the list of conditions by either double clicking it or selecting it and then choosing 

(Edit condition). Alternatively, you can choose the menu path Conditions for Safety Statements → Edit 

Condition. 

 
4. Delete Conditions: 

Delete a condition by selecting it in the list of conditions and choose (Delete condition). Alternatively, use the 

menu path Conditions for Safety Statements → Delete Condition. You can select several conditions for deletion. 
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5. Set Filter  Remove Filter: 

If you have searched for conditions by using the search function,the found conditions are displayed. 

Display all conditions of the conclusive characteristic by choosing  (Remove filter). Alternatively, use the menu 

path Conditions for Safety Statements → Remove Filter. 

Display found conditions using the search function. Choose  (Set filter). Alternatively, use the menu path 

Conditions for Safety Statements → Set Filter. 

If you have searched for conditions via a section, the filter option is not available. 
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3.2 Finding Conditions 
 

 

Figure 8 - Initial Screen 
 

There are two options when searching for conditions. 

 
1. Using the List of Sections. 

Before you search for a condition, you have to know to which characteristic it is assigned. This is because all 

conditions are dependent on a single conclusive characteristic. 

Select the section and the conclusive characteristic to find the condition. 
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2. Using the Search. 

If you do not know exactly to which characteristic a condition is assigned, you can use search terms to find the 

characteristic for your condition. 

The system carries out the search according to: 

- Conclusive Phrase: The system compares the search term with the phrase text, code and key of the 

conclusive phrase of the conditions. 

- Condition: The system compares the search term with the condition number. 

- Fact: The system compares the search term with the characteristic of a fact assigned to the condition 

parameter of the condition. 

- Expression: The system compares the search term with the phrase text, code and key of the expression 

assigned to a fact assigned to the condition parameter of the condition. 

- All: The system combines all search options. 

It is not necessary to use the full search term to find characteristics. 

Example: If you want to search for the conclusive phrase If symptoms persist, call a physician, it is 

sufficient to enter the search term physician. 

Regardless of whether you select a section or carry out a search for a term, the List of Results shows all 

associated characteristics in the following format: 

 

Defined Tree Structure > Value Assignment Type > Characteristic 

For example: 4. First Aid Measures > Hints for Physician > Treatment 

 
 
 
 

 

3.3 Creating Conditions 

 
To create a new condition, proceed as follows: 

1. In the Rule Editor, choose Conditions for Safety Statements → Manage Conditions. 

2. On the Initial Screen, select the section and the conclusive characteristic to which you wish to add the 

new condition. 

3. In the Condition Overview screen, choose  (Create Condition) to create the condition. 

4. Modify the condition details. 

a. Conclusion – The Usage and Phrase fields are mandatory. 

b. Condition Parameter – Add at least one fact or flag one of the checkboxes. 

Add a fact by double-clicking on it in the property tree. 

For more information, see Adding Facts in the Condition Parameter. 

5. When you have created the condition, choose  (Go Back) to return to the list of conditions. 

 
Note 

Instead of creating a new condition, you can copy an existing condition. 
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3.4 Editing Conditions  
Facts 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9 - Edit Conditions 
 

To edit an existing condition, proceed as follows: 

1. In the Rule Editor, choose Conditions for Safety Statements → Manage Conditions. 

2. On the Initial Screen, choose the characteristic in which the condition that you need to edit is located. 

3. Double click the condition that needs to be edited. 

4. You can edit the conclusion or the condition parameter. 

a. To edit the conclusion, choose the values from the dropdown lists. 

a. To edit the condition parameter, choose  (Edit fact) or  (Delete fact) to delete a fact. If you 

wish to add facts to the condition, double click the fact in the property tree. 

For more information, see Adding Facts in the Condition Parameter. 

5. When you have edited the condition, choose  (Go back) to return to the list of conditions. 
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3.4.1 Adding Facts in the Condition Parameter 

 
To add a new Fact to the condition parameter, proceed as follows: 

1. In the property tree, select the fact you wish to add. 

2. Double click the fact. 

3. Select the values and confirm. 

The following results are possible: 

1. If the Fact with the same Logical Operator already exists in the list of facts, this expression is overwritten. 

For phrase-enabled facts, the phrases are added to the expression. 

2. If the fact does not already exist, a new entry is added to the list of facts. 

 
 
 

3.4.2 Editing Facts in the Condition Parameter 

 
To edit an existing Fact from the list, proceed as follows: 

1. Double click the Fact you wish to edit. 

2. Select the values and confirm. 

The following results are possible: 

1. If you change the expression and not the Logical Operator, only the expressions are updated. 

2. If you change the Logical Operator and another entry with the same Fact and Logical Operator already 

exists, the existing entry is overwritten. For phrase-enabled facts, the first and second entries are 

merged. 

 
 

3.4.3 Deleting Facts in the Condition Parameter 

 
To delete an existing Fact, proceed as follows: 

1. Select the Fact in the list. You can select more than one entry. 

2. Choose  (Delete fact) to delete the selected facts. 
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3.5 Deriving Conclusive Phrases 

 
The system needs to carry out two steps to derive a conclusive phrase. Firstly, in the Condition Parameter 

section, either one of the checkboxes has to be flagged, or the facts listed beneath the checkboxes have to be 

fulfilled. The system determines all relevant conclusive phrases from the conditions for one conclusive 

characteristic. The system then determines the phrases that should be transferred to the characteristic according 

to the weight of importance, group and usage. 

For an example, see Example for Deriving Conclusive Phrase. 

 
 
 

3.5.1 Deriving Conclusive Phrases by Condition Parameter 

 
The condition parameter consists of facts with their expressions and logical operators, as well as the two 

parameters Condition parameter is always applicable and Condition parameter is applicable if no other condition 

applies. 

• Condition parameter is always applicable: 

If this checkbox is flagged, the conclusive phrase is always derived. It can only be combined with facts 

using the logical operator NOT to create condition parameters, such as “Always applicable except if …” 

• Condition parameter is applicable if no other condition applies: 

If this checkbox is flagged, the conclusive phrase is derived if no other condition parameter for other 

conditions for the conclusive characteristic applies. Using this condition parameter, you can define a 

fallback conclusive phrase such as “If nothing else applies, then …”. This condition parameter cannot be 

combined with any other condition parameter. 

A fact is a criterion that is applied to a condition parameter. Each fact has an expression that is the value which is 

compared to the value of the characteristic of the fact in the specification. If you add several facts to the condition 

parameter, these are connected with logical operators to express logical terms. 

In CoSSta there are three logical operators which connect the facts. 

In the following examples the terms S Phrases, Symbols, State of Matter, Chemical Characterization, R Phrases 

and Type of Substance are used as a placeholder for facts with assigned expressions. 

• OR: 

The facts are connected with OR. If one of the facts is true, the condition parameter applies. 

For example: 

S Phrases OR Symbols → If either S Phrases or Symbols is true, the condition parameter applies. 

• AND: 

The facts are connected with AND. If all of the facts are true, the condition parameter applies. For 

example: 

State of Matter AND Chemical Characterization → If State of Matter and Chemical Characterization are 

true, the condition parameter applies. 

• NOT: 

The facts are connected with NOT. If all of the facts are false, the condition parameter applies. 

For example: 

NOT R Phrases AND NOT Type of Substance →If R Phrases and Type of Substance are false, the 

condition parameter applies. 
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If you select several facts with different logical operators, they are grouped according to the logical operator. 

These facts are connected with the logical operator AND. In this way, all results of the different logical operators 

have to be true to apply the condition parameter. 

Example: 

• (S Phrases OR Symbols) 

AND (State of Matter AND Chemical Characterization) 

AND (NOT R Phrases AND NOT Type of Substance) 

→ If all grouped facts are true, the condition parameter applies. 

If you select several phrases as an expression for a phrase-enabled fact, the phrases are connected with the 

logical operator OR. If the characteristic value in the specification contains one of the selected phrases, the fact 

applies. 

Example: 

• Expressions for characteristic R Phrases: 

R11 OR R12 OR R14 OR R35 → If the characteristic value in the specification contains at least one of the 

phrases, the fact applies. 

 
 

3.5.2 Determining Phrases to Transfer to the Conclusive 
Characteristic 

 
The conclusive phrase is derived by the condition parameter and by the defined additional phrase parameters for 

the conclusive phrase. 

The condition parameter determines whether the single condition applies. For this reason, the conclusive phrase 

is relevant for the conclusive characteristic. 

The additional phrase parameters of the conclusive phrase determine which conclusive phrases are relevant for 

all conditions assigned to the conclusive characteristic with its usage. These are transferred to the characteristic 

in the specification. 

The following functions are applicable to one conclusive characteristic only. 

• Weight of Importance: 

The weight of importance ensures that the phrase with the highest number has the highest priority. Only, 

the phrase with the highest priority is transferred to the conclusive characteristic in the specification. 

For example (the condition parameter applies): 
 

Condition Usage Conclusive 

Phrase 

Weight of 

Importance 

Group Always 

Write 

Sort Sequence 

1 
 

Phrase A 10 
   

2 
 

Phrase B 20 
   

3 
 

Phrase C 30 
   

➔  Only phrase C is transferred. 
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• Group: 

This clusters phrases that are relevant for a specific area. Only the phrase with the highest number in the 

weight of importance within the group is transferred to the conclusive characteristic in the specification. 

The group is case insensitive. 

For example (the condition parameter applies): 
 

Condition Usage Conclusive 

Phrase 

Weight of 

Importance 

Group Always 

Write 

Sort Sequence 

1 
 

Phrase A 10 A 
  

2 
 

Phrase B 20 A 
  

3 
 

Phrase C 30 B 
  

4 
 

Phrase D 40 B 
  

➔  Phrase B and Phrase D are transferred. 

• Always Write: 

This defines that this phrase is always transferred to the conclusive characteristic if the condition 

parameter applies, and has no impact on the determination of other phrases to be transferred. 

For example (the condition parameter applies): 

Condition Usage Conclusive 

Phrase 

Weight of 

Importance 

Group Always 

Write 

Sort Sequence 

1 
 

Phrase A 10 
   

2 
 

Phrase B 
  

Yes 
 

3 
 

Phrase C 20 
   

➔  Phrase B and Phrase C are transferred. 

• Sort Sequence: 

This defines the order in which the derived phrases are transferred to the conclusive characteristic in the 

specification. 

For example (the condition parameter applies): 
 

Condition Usage Conclusive 

Phrase 

Weight of 

Importance 

Group Always 

Write 

Sort Sequence 

1 
 

Phrase A 
  

Yes 10 

2 
 

Phrase B 
  

Yes 20 

3 
 

Phrase C 
  

Yes 30 

➔  The phrases are transferred in the following order: Phrase A, Phrase B, Phrase C. 
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• Usage: 

The usage specifies which usage is used when the phrase is transferred to the specification. The 

additional phrase parameters of the conclusive phrase are evaluated per usage. 

For example (the condition parameter applies): 
 

Condition Usage Conclusive 

Phrase 

Weight of 

Importance 

Group Always 

Write 

Sort Sequence 

1 Usage A Phrase A 10 
   

2 Usage A Phrase B 20 
   

3 Usage B Phrase C 30 
   

4 Usage B Phrase D 40 
   

➔  Phrase B and Phrase D are transferred. 
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4 Determining Secondary Data 

 
 

4.1 Working with the EH&S Expert 
 

Before you can use the Rule for Safety Statements, you need to copy the required files and register the rule set 

to the EH&S Expert Server. You can register the rule set as follows: 

• For more information on EH&S Expert Administration, see the documentation for the Customizing 

activity Set Up Windows Registry under Environment, Health and Safety → Basic Data and Tools → Tools 

→ EH&S Expert 

• For more information on EH&S Service Administration, see Basic Data and Tools → Tools → EH&S 

Service Administration 

 
Recommendation 

For performance reasons, SAP recommends you locate both the Rule for Safety Statements and the 

CoSSta access file on the EH&S Expert server. However, other locations are also possible provided they 

can be accessed by the EH&S Expert server without restrictions. 

 
The CoSSta access file is assigned in the record mapping table of the Rule for Safety Statements rule set. The 
rule set contains the regulations for mapping records in this set of rules. If you renamed the CoSSta access file, 
you need to change the assignment in the record mapping table of the Rule for Safety Statements rule set. 
Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the record mapping table ExpRecordMap. 

3. Edit the External_id field with the Syntax T:<Table>/<Database> for the data record with Internal_id 

definitions. 

Change the database name to the renamed access file name (case sensitivity). 
 

Figure 10 – Record Mapping Table in the CoSSta_MSDS.mdb 
 

For more information, see Basic Data and Tools → Specification Editing → Secondary Data Determination 

→ EH&S Expert → How the EH&S Expert Works → Mapping Table → Record Mapping. 
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4.2 Assigning Rules for Safety Statements in the EHS System 
 

The Rule for Safety Statements from the EH&S Expert Server has to be registered in the user exit management 

in the EHS system. 

Start the Customizing activity Manage User Exits under Environment, Health and Safety → Basic Data and Tools → 

Basic Settings. Create a user exit of the user exit category SUB_SEDACA and enter the reference module. Assign 

the Rule for Safety Statements rule set to the parameter EXPERT_RULE_SET. 

For more information, see the documentation in the Customizing activity for Extend Entry in Secondary Data 

Determination under Environment, Health and Safety → Basic Data and Tools → Tools → EH&S Expert. 

 

Recommendation 

When you carry out the Rule for Safety Statements rule set within the rule set sequence, specify the 

Rule for Safety Statements rule set at the end of this rule set sequence. 

For more information, see the documentation in the Customizing activity Configure Call of Rule Sets in a 

Rule Set Sequence under Environment, Health and Safety → Basic Data and Tools → Tools → EH&S 

Expert. 

 
 

4.3 Starting the Determination 

 
To determine the secondary data with the Rule for Safety Statements rule set in EHS system, proceed as 

follows: 

1. Go to Specification Workbench (Transaction CG02BD). 

2. Search for specifications for which you want to determine secondary data. 

3. In the hit list, select the required specification and choose Utilities → Secondary Data → Determination. 

4. Select the User Exit for Rule for Safety Statements and choose  (Transfer). 

5. Enter the parameter and choose  (Start data determination) to start the secondary data determination. 

For more information, see the documentation under Basic Data and Tools → Specification Editing → Secondary 

Data Determination → EH&S Expert → How the EH&S Expert Works → Determining Secondary Data with the EH&S 

Expert. 
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5 Managing Phrases 

 
 

CoSSta distinguishes between conclusive phrases and condition parameter phrases. Both phrase types consist of 

the following: 

- Phrase Key: Identifies the phrase in the EHS System. 

- Phrase Code: Is a language-dependent abbreviation for a phrase. 

- Phrase Text: Specifies the first 132 characters contained in a phrase. 

To open the Manage Phrase screen, choose Conditions for Safety Statements → Manage Phrases in the Rule 

Editor. 
 

Note 

You can change the sort sequence within the column by selecting the column header. 

The conclusive phrase is used in the conclusion of a condition. This is the phrase which is transferred to the 

characteristic in the selected specification. 

The conclusive phrase also consists of the following: 

1. Group: 

If several conditions for the selected characteristic match and the grouping of phrases have been 

specified, the phrase with the highest weight of importance from each group is transferred to the 

characteristic in the selected specification. 

2. Weight of Importance: 

The phrase with the highest number has the highest priority. For example, a phrase with a weight of 

30 takes priority over a phrase with a weight of 10. 

If several conditions for the selected characteristic match, the phrase from the same usage with the 

highest weight of importance is transferred to the characteristic in the selected specification. 

3. Sort Sequence: 

If several conditions for the selected characteristic match, phrases with the same usage are 

transferred in the specified sort sequence to the characteristic in the selected specification. 

If the sort sequence of a phrase has not been specified, the phrase is transferred last. 

4. Always Write: 

If several conditions for the selected characteristic match, phrases with the same usage and 

specified with ‘Always Write’ are always transferred to the characteristic in the selected 

specification. 

5. Hide: 

The phrase is hidden in the phrase selection of the conclusive phrase. It can no longer be selected. 

This has no effect on existing conditions. Use this function to reduce the number of phrases that can 

be selected to the ones you need, without the need to delete them. 
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You can manage conclusive phrases or condition parameter phrases. 

You can display an overview of the existing phrases for both types by selecting the characteristic in the property 

tree on the left side of the screen. 

 

Note 

In the predefined settings, the list is sorted by phrase code and phrase text. However, you can change the 

sort sequence within the column by selecting the column header. 

You can delete existing phrases in the characteristic by selecting the phrase or phrases and then choosing  

(Delete phrase). Alternatively, you can use the menu path Phrases -> Delete Phrase. 
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5.1 Conclusive Phrases 
 
 

Figure 11 – Manage Phrases - Conclusive Phrases 
 

If you select Conclusive Phrases in the dropdown list, the conclusive characteristics are displayed in the property 

tree. If you select a characteristic, all phrases of this characteristic are displayed in the Phrase List. 

You can define the group, weight of importance, sort sequence, always write and hide values of the phrases in the 

corresponding fields. 

 

Note 

Changes made to entries are saved in the system without a prompt. These changes have no effect on 

existing conditions. 

Phrase List 
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5.2 Condition Parameter Phrases 
 
 
 
 

Figure 12 – Manage Phrases - Condition Parameter Phrases 

 

If you select Condition Parameter Phrases in the dropdown list, the characteristics are displayed in the property 

tree. If you select a characteristic, all phrases of this characteristic are displayed in the Phrase List. 

You can only delete phrases here. 

Phrase List 
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5.3 Editing Conclusive Phrases 

 
To edit an existing Conclusive Phrase, proceed as follows: 

1. Open the Manage Phrases screen in the Rule Editor by choosing Conditions for Safety Statements → 

Manage Phrases. 

2. Choose the entry Conclusive Phrases from the dropdown list. 

3. Select the characteristic for which you wish to edit the phrases. The list of phrases is displayed for the 

characteristic. 

4. Search for the phrase you wish to edit and change the values. The changes are saved immediately and 

have no effect on existing conditions. 

 

Note 

You have to flag either the Always Write checkbox or define the Weight of Importance. The Weight of 

Importance field must not be empty, and the Always Write checkbox must not be flagged, if you maintain 

a Group. 

 

Note 

If you change the phrase parameters, the changes are transferred to existing conditions. 

 
 
 

5.4 Deleting Phrases 

 
To delete either a conclusive phrase or a condition parameter phrase, proceed as follows: 

1. Open the Manage Phrases screen in the Rule Editor by choosing Conditions for Safety Statements → 

Manage Phrases. 

2. Choose either Conclusive Phrases or Condition Parameter Phrases from the dropdown list. 

3. Select the phrase you wish to delete. 

4. Choose  (Delete phrases) to delete the entry. You can delete several phrases at once. 

 
Note 

The system checks if the phrase is being used in a condition and prevents the deletion of the phrase in 

the characteristic if this is the case. For this reason, you need to delete all dependencies to conditions 

before the phrase can be deleted. 
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5.5 Importing Phrases 

 
To import conclusive phrases and condition parameter phrases into CoSSta, you have to import the Property 

Tree for Safety Statements. For more information, see Importing Property Tree and Phrases. 

The phrases are automatically imported for all conclusive characteristics and all phrase-enabled condition 

parameter characteristics of the property tree. 

 

Note 

If a phrase already exists the Phrase Text and Code are updated. 

 
Note 

If a conclusive phrase is new, all phrase parameter are empty. However, the Always Write checkbox is 

flagged. 
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6 Advanced Functions 

 
 

In the Rule Editor, choose Conditions for Safety Statements → Advanced Functions. Here, you can manage usage 

profiles, edit identification types, edit customer-specific characteristics, export conditions and migrate the MSDS- 

Maker database that CoSSta replaces. 

 
 

6.1 Managing Usage Profiles 

 
The usages defined in a usage profile are transferred to the conclusive characteristic together with the conclusive 

phrase. If several conditions for the conclusive characteristic match, the conclusive phrase from the same usage 

is transferred to the characteristic in the selected specification. 

Figure 13 – Usage in the Specification Workbench 
 

A usage consists of the following elements: 

- Rating 

- Validity Area 

- Active 

- Excluding 

For more information, see Environment, Health and Safety → Basic Data and Tools → Specification Management 

→ Additional Information for Value Assignment → Usage in the Customizing of your EH&S system. 
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To open the Manage Usage Profile function of CoSSta in the Rule Editor choose Conditions for Safety Statements 

→ Advanced Functions → Manage Usage Profiles. 

 
 
 

6.1.1 Overview 
 
 

Figure 14 - Manage Usage Profiles - Overview 
 

This screen provides all usage profiles available in CoSSta. 

You can create a new usage profile, edit an existing one or delete a usage profile. 
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6.1.2 Edit Usage Profile 
 

Figure 15 - Manage Usage Profiles - Edit Usage Profile 
 

In the Edit Usage Profile screen, you define usages. 

Each usage profile requires a unique name. Each entry in the list represents one usage and is assigned to this 

usage profile. 

 
To edit an existing Usage Profile, proceed as follows: 

1. Open the Manage Usage Profiles screen. 

2. Select the Usage Profile you wish to edit by double clicking it. 

3. Edit the values you wish to change and confirm your entries by choosing Done. The changes are saved 

immediately. 

 

Note 

You cannot change the name of the Usage Profile. To change the name, you need to create a new Usage 

Profile. 

 

Note 

If you change the usages in the Usage Profile, the changes are transferred to existing conditions. 
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6.1.3 Creating Usage Profiles 

 
To create a usage profile, proceed as follows: 

1. Open the Manage Usage Profiles screen. 

2. Choose  (Create usage Profile). You will proceed to the next screen to edit the values for the Usage 

Profile. 

3. Enter a unique name for the Usage Profile. 

4. Enter values. Choose  (Add usage) to add more usages. 

5. Choose Done to save your entry. 

 
Note 

The Rating and the Validity Area are mandatory for each usage and have to exist in the corresponding 

EHS system. The rating and validity area are not checked in CoSSta. 

To manage the Rating in your EHS system, carry out the Customizing activity Specify Ratings under 

Environment, Health and Safety → Basic Data and Tools → Specification Management → Additional 

Information for Value Assignment. 

To manage the Validity Area in your EHS system, carry out the Customizing activity Specify Validity Areas 

under Environment, Health and Safety → Basic Data and Tools → Specification Management → Additional 

Information for Value Assignment → Usage. 

 
 

6.1.4 Deleting Usage Profiles 

 
To delete an existing Usage Profile, proceed as follows: 

1. Open the Manage Usage Profiles screen. 

2. Select the Usage Profile you wish to delete. You can select several Usage Profiles for deletion. 

3. Choose  (Delete usage profile). The deletion has no effect on existing conditions. 
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6.2 Editing Identification Types 
 

Figure 16 - Edit Identification Types 
 

The identification types managed in CoSSta are used as facts in the property tree in the Edit Condition screen. 

You can define up to three identifiers. The description for the identifier is entered in the fact once you re-import 

the property tree. 

For each identifier, Identification Category and Identification Type is a mandatory field. The category can either 

have the value NAM, NUM or FRM. 

 
To edit an identification type, proceed as follows: 

1. Open the Edit Identification Types under Conditions for Safety Statements → Advanced Functions. 

2. Change the values for the identifiers. 

3. To confirm you changes, choose Done. 

 
Note 

The Identification Category and the Identification Type are mandatory values for each identifier and must 

exist in the corresponding EHS system. The identification category and type are not checked in CoSSta. 

To manage the Identification Type in your EHS system, choose the Customizing activity Environment, 

Health and Safety → Basic Data and Tools → Specification Management → Specification Master → Check 

Identification Types. 
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Note 

The identifiers you defined in CoSSta are not automatically used in the Rule for Safety Statements. If 

you wish to use these identifiers, you also have to adjust the mapping of the rule set of the defined 

identifiers. 

You need to change the assignments in the fact mapping table and record mapping table of the rule set. 

Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the fact mapping table ExpFactMap. 

3. Edit the External_id field with the Syntax I:<Category>,<Type> for the data record of the 

identifier with Internal_id of the defined identifiers. 

Figure 17 – Fact Mapping Table in CoSSta_MSDS.mdb 
 

For more information, see Basic Data and Tools → Specification Editing → Secondary Data 

Determination → EH&S Expert → How the EH&S Expert Works → Mapping Table → Fact Mapping. 

 

Recommendation 

We recommend you re-import the property tree once you have defined identifiers. In this way, the 

description for the identifier is displayed in the property tree. Otherwise, only the technical keys are 

displayed. 
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6.3 Editing Customer-Specific Characteristics 

 
The customer-specific characteristics defined in CoSSta are used as conclusive characteristics or as phrase- 

enabled condition parameter characteristics. 
 

Figure 18- Edit Customer-Specific Characteristics – Conclusive Characteristics 
 

You can define up to 50 conclusive and up to 50 condition parameter characteristics. The description for these 

characteristics is displayed when you import the property tree. 

You must assign your customer-specific characteristics to the Property Tree for Safety Statements in the EHS 

system in order that phrases and descriptors are imported automatically: 

 

Note 

Assign the value assignment types of Conclusive Characteristics to the property tree below the 

CONCLUSION node, for example, value assignment type SAP_EHS_COSSTA_CONCLUSION with the 

ID 100000. 

Assign the value assignment types of Condition Parameter Characteristics to the property tree below the 

FACTS node, for example, value assignment type SAP_EHS_COSSTA_FACTS with the ID 200000. 

To assign the value assignment types to the property tree in your EHS system, choose the Customizing 

activity Environment, Health and Safety → Basic Data and Tools → Specification Management → 

Specification Database Structure → Settings for Value Assignment → Set Up Property Trees. 

If the customer-specific characteristic is not assigned in the property tree, phrases are not assigned to the 

characteristic in CoSSta, and the characteristic cannot be used. 

 
To edit customer-specific characteristics, proceed as follows: 

1. Open the Edit Customer-Specific Characteristics screen by choosing Conditions for Safety Statements → 

Advanced Functions. 

2. Choose either the Conclusive Characteristics or the Condition Parameter 

Characteristics from the dropdown list. The default value is Conclusive Characteristics. 

3. Change the values for the customer-specific characteristics. 

4. Confirm your changes by choosing Done. 
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Note 

The Value Assignment Type and the Characteristic are mandatory values for each customer-specific 

characteristic and have to exist in the corresponding EHS system. The value assignment type and the 

characteristic are not checked in CoSSta. 

To manage the Value Assignment Type in your EHS system, choose the Customizing activity 

Environment, Health and Safety → Basic Data and Tools → Specification Management → Specification 

Database Structure → Settings for Value Assignment → Specify Value Assignment Types. 

To manage the Characteristics in your EHS System, choose the transaction Cross-Application 

Components → Classification System → Master Data → Characteristics. 

 

Note 

The customer-specific characteristics you defined in CoSSta are not automatically used in the Rule for 

Safety Statements. If you wish to use these characteristics, you also have to adjust the mapping of the 

rule set of the defined customer-specific characteristics. 

You need to change the assignments in the fact mapping table and record mapping table of the rule set. 

Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the record mapping table ExpRecordMap. 

3. Edit the External_id field with the Syntax M:<Value assignment type> for the data record with 

Internal_id of the customer-specific characteristics. 
 

Figure 19 – Record Mapping Table in the CoSSta_MSDS.mdb 
 

4. Open the fact mapping table ExpFactMap. 

5. Edit the External_id field with the Syntax M:<Characteristic> for the data record of the customer- 

specific characteristics. 

For conclusive characteristics, change data records with the Internal_id o_phrase and Record 

starting with ZAP_EHS_CUSTOM_. 

For condition parameter characteristics, change data records with the Internal_id i_crit and 

Record starting with CUST_. 
 

Figure 20 – Fact Mapping Table in the CoSSta_MSDS.mdb 
 

For more information, see Basic Data and Tools → Specification Editing → Secondary Data Determination 

→ EH&S Expert → How the EH&S Expert Works → Mapping Table. 
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Recommendation 

We recommend you re-import the property tree once you have defined your customer-specific 

characteristics. In this way, the description for the characteristic is displayed in the property tree. 

Otherwise, only the technical keys are displayed. 

 
 

6.4 Exporting Conditions 

 
The export function transfers the data of all conditions to a CSV file. 

To export conditions, procced as follows: 

1. Open the Rule Editor and choose Conditions for Safety Statements → Choose Database. 

2. Select the access file for which you want to export the conditions and choose Done. 

3. In the Rule Editor, choose Conditions for Safety Statements → Advanced Functions → Export Conditions. 

4. Select or enter the CSV file, in which you want to transfer the conditions. 

5. Once the export is complete, the CSV file opens. 

 
 
 

6.5 Migrating the MSDS-Maker Database 
 

 

Figure 21 - Migrate Database 
 

Migration includes the defined conditions (previously called rules) and the phrases used in the MSDS-Maker with 

their additional values. 

 
To migrate the MSDS-Maker database, proceed as follows: 

1. Open the Migrate Database screen by choosing Conditions for Safety Statements → Advanced Functions 

→ Migrate Database. 

2. In the Old Database field, select your MSDS-Maker database by choosing Browse. 

3. In the New Database field, select your new CoSSta database by choosing Browse. 

4. Choose Start Migration. 

In this way, the conditions of the old MSDS-Maker database are migrated one-to-one to the existing 

conditions of the CoSSta.mdb access file. 

The phrases from the MSDS-Maker database are adjusted to meet the new data format for phrases. If a 

phrase already exists in the target phrase set for the characteristic, the phrase text, phrase code and the 

additional values are adjusted. Duplicate phrases are not created. 
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Note 

If you have more than one instance of the old MSDSMaker.mdb access file, it is possible to migrate all of 

these. Duplicate conditions have to be deleted manually. 

If you migrate more than one instance of the old MSDSMaker.mdb access file, the database you migrate 

last sets the values for the phrases. 

 

Note 

The usage profiles, identification types and customer-specific characteristics are not migrated 

automatically. You have to define them in CoSSta again manually. 

 

Recommendation 

We recommend that you use the provided CoSSta.mdb access file as the target database for the 

migration. It contains standard values, such as supported characteristics which are used in the Rule for 

Safety Statements rule set. 

 

Recommendation 

We recommend you import the current Property Tree for Safety Statements after the migration of the 

MSDSMaker.mdb access file for the most recent phrases. 

 

Recommendation 

If you want to migrate more than one instance of the old MSDSMaker.mdb access file, you have to check 

whether you use different customer-specific characteristics in the instances of the old MSDSMaker.mdb 

access file. 

To migrate more than one instance of the MSDSMaker database, proceed as follows: 

1. Assign the customer-specific characteristics in the new CoSSta database. For more information, see 

Editing Customer-Specific Characteristics. 

2. Open the MSDSMaker.mdb access file using Microsoft Office Access. 

3. Open the table INTERFACE_TAB. 

4. Replace every customer-specific characteristic for conclusive characteristics starting with 

ZAP_EHS_CUSTOM_ and condition parameter characteristics starting with CUST_. 
 

Figure 22 - Find and Replace in the access file (STRG+H) 
 

Enter the exact Internal_ID of the old MSDSMaker database in the Find What field and the exact 

Internal_ID of the new CoSSta database in the Replace With field. Choose Current document in Look 

In field and Any Part of Field in the Match field. 

5. Confirm every replacement. 

6. Save the MSDSMaker.mdb access file. 

7. Migrate the MSDS-Maker database to the new CoSSta database. 



Conditions for Safety Statements 

Glossary 

CUSTOMER 

© 2015 SAP SE or an SAP affiliate company. All rights reserved. 42 

 

 

 
 
 
 

7 Glossary 
 
 
 

 
Term Definition 

Conclusive 

Characteristic 

The characteristic in the selected specification to which the conclusive phrase is 

transferred. Several conditions can be assigned to the conclusive characteristic 

from which conclusive phrases are derived. 

Condition Consists of a condition parameter (if…) and its conclusion (then…). 

Example: If the material causes irritation, then "Move to fresh air. ". 

Condition Parameter Consists of facts, logical operators and expressions. 

Conclusion Consists of a conclusive phrase and the usage. The conclusive phrase is transferred 

to the conclusive characteristic. The usage is transferred to the value assignment 

instance of the conclusive characteristic. 

Conclusive Phrase Is transferred to the conclusive characteristic. The phrase is assigned to a condition 

of the conclusive characteristic. It is derived on the basis of the usage, the condition 

parameter and the additional phrase parameters. 

Fact The criteria used to assign values for the condition parameter. Using the fact, the 

Rule for Safety Statements determines the characteristic value in the 

specification. The characteristic value is compared with the expression. 

A fact can be a specification, an identifier, a predefined condition, a phrase-enabled 

or a numeric characteristic. 

Expression Is compared with the characteristic value of the fact. If the expression applies for 

the characteristic value, the condition parameter is fulfilled. 

Logical Operator Connects two or more facts. Logical operators are OR, AND and NOT. 

Predefined Condition Is the combination of rules that are carried out in the Rule for Safety Statements. 

The conclusion of this predefined condition is compared with the expression. 

Phrase Parameter The sort sequence, the group, the weight of importance and the "Always Write" flag, 

that can be specified for a conclusive phrase. 

Sort Sequence Order in which conclusive phrases are transferred to the conclusive characteristic. 

Weight of Importance The phrase with the highest number has the highest priority. For example, a phrase 

with a weight of 30 has priority over a phrase with a weight of 10. 

A conclusive phrase with the highest weight of importance is transferred to the 

conclusive characteristic. 

Group Groups conclusive phrases together in a specific context, Conclusive phrases with 

the highest weight of importance per group are transferred to the conclusive 

characteristic. 
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8 Appendix 

 
 

8.1 Example for Deriving Conclusive Phrase 

 
In CoSSta, the following conditions for the conclusive characteristic Advice of the value assignment type First 

Aid:Skin exist. The usage World Wide is assigned to the condition. 

Condition Condition Parameter Conclusive 

Phrase 

Weight of 

Importance 

Group Always 

Write 

Sort 

Sequence 

1 R Phrase = R21 Phrase A 10 
  

20 

2 R Phrase = R22 

AND State of Matter = solid 

Phrase B 20 
  

10 

3 R Phrase = R21 

OR State of Matter = solid 

Phrase C 20 A 
 

50 

4 Always applicable 

AND NOT R Phrase = R22 

Phrase D 10 A 
 

40 

5 R Phrase = R21 

OR State of Matter = solid 

Phrase E 
  

Yes 30 

6 Applicable if no other condition 

applies 

Phrase F 
  

Yes 
 

 

Secondary data is determined based on the Rule for Safety Statements rule set for the following specifications: 

 
1. Specification A: 

• Existing data: 

The specification contains the phrase <R21> in the characteristic R Phrase. 

• Result: 

The rule set transfers the phrases <Phrase A>, <Phrase E> and <Phrase C> to the 

characteristic Advice of the value assignment type First Aid:Skin. 
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Explanation: 

The rule set compares the characteristic value <R21> with the expressions of the condition parameter in 

the specified conditions: 

Condition Applicable Explanation 

1 X The characteristic value in the characteristic R Phrase contains <R21>. 

2 
 

The characteristic value in the characteristic R Phrase does not contain 

<R22>. The characteristic State of Matter does not contain a characteristic 

value. 

3 X The characteristic value in the characteristic R Phrase contains <R21>. 

The characteristic State of Matter does not contain a characteristic value. 

4 X The condition parameter is always applicable and the characteristic values in 

the characteristic R Phrase do not contain <R22>. 

5 X The characteristic value in the characteristic R Phrase contains <R21>. The 

characteristic State of Matter does not contain a characteristic value. 

6 
 

Conditions 1, 3, 4 and 5 apply. 

The conclusive phrases <Phrase A>, <Phrase C>, <Phrase D> and <Phrase E> are relevant for 

deriving the conclusive phrase. 

The rule set checks the group, the weight of importance and the indicator Always Write of the relevant 

phrases <Phrase A>, <Phrase C>, <Phrase D> and <Phrase E> and determines the phrases to 

transfer to the conclusive characteristic. 

Condition Phrase Determined Explanation 

1 Phrase A X The phrase has the greatest weight of importance without a group. 

3 Phrase C X The phrase has the greatest weight of importance within group A. 

4 Phrase D 
 

The weight of importance is less than the weight of importance of 

<Phrase C> within group A. 

5 Phrase E X The indicator Always Write is assigned. 

The conclusive phrases <Phrase A>, <Phrase C> and <Phrase E> are relevant for the transfer to the 

conclusive characteristic. 

The rule set specifies the sort sequence of the conclusive phrases. 

Phrase Sort Sequence 

Phrase A 20 

Phrase E 30 

Phrase C 50 

The rule set transfers <Phrase A>, <Phrase E> and <Phrase C> in the specified sort sequence to the 

conclusive characteristic. 
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2. Specification B: 

• Existing data: 

The specification contains the phrase <R21> in the characteristic R Phrase. 

The specification contains the phrase <solid> in the characteristic State of Matter. 

• Result: 

The rule set transfers the phrases <Phrase A>, <Phrase E> and <Phrase C> to the 

characteristic Advice of the value assignment type First Aid:Skin. 

Explanation: 

The rule set compares the characteristic value <R21> of the characteristic R Phrase and the 

characteristic value <solid> of the characteristic State of Matter with the expressions of the 

condition parameter in the specified conditions: 

Condition Applicable Explanation 

1 X The characteristic value in the characteristic R Phrase contains <R21>. 

2 
 

The characteristic value in the characteristic R Phrase does not contain 

<R22>. The characteristic value in the characteristic State of Matter 

contains <solid>. 

3 X The characteristic value in the characteristic R Phrase contains <R21>. 

The characteristic value in the characteristic State of Matter contains 

<solid>. 

4 X The condition parameter is always applicable and the characteristic values in 

the characteristic R Phrase do not contain <R22>. 

5 X The characteristic value in the characteristic R Phrase contains <R21>. The 

characteristic value in the characteristic State of Matter contains <solid>. 

6 
 

Conditions 1, 3, 4 and 5 apply. 

The conclusive phrases <Phrase A>, <Phrase C>, <Phrase D> and <Phrase E> are relevant for 

deriving the conclusive phrase. 

The rule set checks the group, the weight of importance and the indicator Always Write of the relevant 

phrases <Phrase A>, <Phrase C>, <Phrase D> and <Phrase E> and determines the phrases to 

transfer to the conclusive characteristic. 

Condition Phrase Determined Explanation 

1 Phrase A X The phrase has the greatest weight of importance without a group. 

3 Phrase C X The phrase has the greatest weight of importance within group A. 

4 Phrase D 
 

The weight of importance is less than the weight of importance of 

<Phrase C> within group A. 

5 Phrase E X The indicator Always Write is assigned. 

The conclusive phrases <Phrase A>, <Phrase C> and <Phrase E> are relevant for the transfer to the 

conclusive characteristic. 
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The rule set specifies the sort sequence of the conclusive phrases. 
 

Phrase Sort Sequence 

Phrase A 20 

Phrase E 30 

Phrase C 50 

The rule set transfers the <Phrase A>, <Phrase E> and <Phrase C> in the specified sort sequence to 

the conclusive characteristic. 

 
3. Specification C: 

• Existing data: 

The specification contains the phrase <solid> in the characteristic State of Matter. 

• Result: 

The rule set transfers the phrases <Phrase E> and <Phrase C> in the characteristic Advice of 

the value assignment type First Aid:Skin. 

Explanation: 

The rule set compares the characteristic value <solid> of the characteristic State of Matter with 

the expressions of the condition parameter in the specified conditions: 

Condition Applicable Explanation 

1 
 

The characteristic R Phrase does not contain a characteristic value. 

2 
 

The characteristic R Phrase does not contain a characteristic value. 

The characteristic value in the characteristic State of Matter contains 

<solid>. 

3 X The characteristic R Phrase does not contain a characteristic value. 

The characteristic value in the characteristic State of Matter contains 

<solid>. 

4 X The condition parameter is always applicable and the characteristic R Phrase 

does not contain a characteristic value. 

5 X The characteristic R Phrase does not contain a characteristic value. The 

characteristic value in the characteristic State of Matter contains <solid>. 

6 
 

Conditions 3, 4 and 5 apply. 

The conclusive phrases <Phrase C>, <Phrase D> and <Phrase E> are relevant for deriving the 

conclusive phrase. 
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The rule set checks the group, the weight of importance and the indicator Always Write of the relevant 

phrases <Phrase C>, <Phrase D> and <Phrase E> and determines the phrases to transfer to the 

conclusive characteristic. 

Condition Phrase Determined Explanation 

3 Phrase C X The phrase has the greatest weight of importance within group A. 

4 Phrase D 
 

The weight of importance is less than the weight of importance of 

<Phrase C> within group A. 

5 Phrase E X The indicator Always Write is assigned. 

The conclusive phrases <Phrase C> and <Phrase E> are relevant for the transfer to the conclusive 

characteristic. 

The rule set specifies the sort sequence of the conclusive phrases. 

Phrase Sort Sequence 

Phrase E 30 

Phrase C 50 

The rule set transfers <Phrase E> and <Phrase C> in the specified sort sequence to the conclusive 

characteristic. 

 
4. Specification D: 

• Existing data: 

The specification contains the phrase <R22> in the characteristic R Phrase. 

• Result: 

The rule set transfers the phrase <Phrase F> in the characteristic Advice of the value assignment 

type First Aid:Skin. 

Explanation: 

The rule set compares the characteristic value <R22> in the characteristic R Phrase with the 

expressions of the condition parameter in the specified conditions: 

Condition Applicable Explanation 

1 
 

The characteristic value in the characteristic R Phrase does not contain 

<R21>. 

2 
 

The characteristic value in the characteristic R Phrase contains <R22>. 

The characteristic State of Matter does not contain a characteristic value. 

3 
 

The characteristic value in the characteristic R Phrase does not contain 

<R21>. The characteristic State of Matter does not contain a characteristic 

value. 

4 
 

The condition parameter is always applicable and the characteristic values in 

the characteristic R Phrase contain <R22>. 

5 
 

The characteristic value in the characteristic R Phrase does not contain 

<R21>. The characteristic State of Matter does not contain a characteristic 

value. 

6 X No other condition applies. 
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The conclusive phrase <Phrase F> is relevant for deriving the conclusive phrase. 

It is not necessary to check the group, the weight of importance and the indicator Always Write of the 

relevant phrase because the rule set derives only one phrase. 

The rule set transfers <Phrase F> to the conclusive characteristic. 

 
5. Specification E: 

• Existing data: 

The specification contains the phrase <R22> in the characteristic R Phrase. 

The specification contains the phrase <solid> in the characteristic State of Matter. 

• Result: 

The rule set transfers the phrases <Phrase B>, <Phrase E> and <Phrase C> in the characteristic 

Advice of the value assignment type First Aid:Skin. 

Explanation: 

The rule set compares the characteristic value <R22> of the characteristic R Phrase and the 

characteristic value <solid> of the characteristic State of Matter with the expressions of the 

condition parameter in the specified conditions: 

Condition Applicable Explanation 

1 
 

The characteristic value in the characteristic R Phrase does not contain 

<R21>. 

2 X The characteristic value in the characteristic R Phrase contains <R22>. 

The characteristic value in the characteristic State of Matter contains 

<solid>. 

3 X The characteristic value in the characteristic R Phrase does not contain 

<R21>. The characteristic value in the characteristic State of Matter 

contains <solid>. 

4 
 

The condition parameter is always applicable and the characteristic R Phrase 

contains <R22>. 

5 X The characteristic value in the characteristic R Phrase does not contain 

<R21>. The characteristic value in the characteristic State of Matter 

contains <solid>. 

6 
 

Conditions 2, 3 and 5 apply. 

The conclusive phrases <Phrase B>, <Phrase C> and <Phrase E> are relevant for deriving the 

conclusive phrase. 

The rule set checks the group, the weight of importance and the indicator Always Write of the relevant 

phrases <Phrase B>, <Phrase C> and <Phrase E> and determines the phrases to transfer to the 

conclusive characteristic. 

Condition Phrase Determined Explanation 

2 Phrase B X The phrase has the greatest weight of importance without a group. 

3 Phrase C X The phrase has the greatest weight of importance within group A. 

5 Phrase E X The indicator Always Write is assigned. 
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The conclusive phrases <Phrase B>, <Phrase C> and <Phrase E> are relevant for the transfer to the 

conclusive characteristic. 

The rule set specifies the sort sequence of the conclusive phrases. 
 

Phrase Sort Sequence 

Phrase B 10 

Phrase E 30 

Phrase C 50 

The rule set transfers the <Phrase B>, <Phrase E> and <Phrase C> in the specified sort sequence to 

the conclusive characteristic. 

 
6. Specification F: 

• Existing data: 

The specification contains the phrase <R23> in the characteristic R Phrase. 

Result: 

The rule set transfers the phrase <Phrase F> in the characteristic Advice of the value assignment 

type First Aid:Skin. 

Explanation: 

The rule set compares the characteristic value <R22> of the characteristic R Phrase with the 

expressions of the condition parameter in the specified conditions: 

Condition Applicable Explanation 

1 
 

The characteristic value in the characteristic R Phrase does not contain 

<R21>. 

2 
 

The characteristic value in the characteristic R Phrase does not contain 

<R22>. The characteristic State of Matter does not contain a characteristic 

value. 

3 
 

The characteristic value in the characteristic R Phrase does not contain 

<R21>. The characteristic State of Matter does not contain a characteristic 

value. 

4 X The condition parameter is always applicable and the characteristic R Phrase 

does not contain <R22>. 

5 
 

The characteristic value in the characteristic R Phrase does not contain 

<R21>. The characteristic State of Matter does not contain a characteristic 

value. 

6 
 

Condition 4 applies. 

The conclusive phrase <Phrase D> is relevant for deriving the conclusive phrase. 

It is not necessary to check the group, the weight of importance and the indicator Always Write of the 

relevant phrase because the rule set derives only one phrase. 

The rule set transfers <Phrase F> to the conclusive characteristic. 
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8.2 Predefined Conditions 

 
A predefined condition is one of the rules carried out in the Rule for Safety Statements. If the result of the 

predefined condition is equal to the entered expression, the condition parameter applies. 

The rules check different characteristics in the selected specifications depending on the entered expression. It 

then derives the conclusion of the predefined condition. 

 
 

8.2.1 Hazardous Substance 

 
The predefined condition Hazardous Substance checks whether 

• The value assignment type GHS Labeling (EMEA) contains phrases in the characteristics Hazard 

Statements and Supplem. Hazard Statements, or 

• The value assignment type GHS Labeling (General) contains phrases in the characteristics Hazard 

Statements and Supplem. Hazard Statements, or 

• The value assignment type Labeling (EU) contains phrases in the characteristics Hazard Symbol and 

R Phrases. 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

No (GHS EMEA) If the value assignment type GHS Labeling (EMEA) does not contain phrases in the 

characteristics Hazard Statements and Supplem. Hazard Statements, the 

predefined condition applies. 

No (Labeling EU) If the value assignment type Labeling (EU) does not contain phrases in the 

characteristics Hazard Symbol and R Phrases, the predefined condition applies. 

No (GHS General) If the value assignment type GHS Labeling (General) does not contain phrases in 

the characteristics Hazard Statements and Supplem. Hazard Statements, the 

predefined condition applies. 

Yes (GHS EMEA) If the value assignment type GHS Labeling (EMEA) contains phrases in the 

characteristics Hazard Statements and Supplem. Hazard Statements, the 

predefined condition applies. 

Yes (Labeling EU) If the value assignment type Labeling (EU) contains phrases in the characteristics 

Hazard Symbol and R Phrases, the predefined condition applies. 

Yes (GHS General) If the value assignment type GHS Labeling (General) contains phrases in the 

characteristics Hazard Statements and Supplem. Hazard Statements, the 

predefined condition applies. 
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Characteristics used in the predefined condition: 
 

Description Characteristic Value Assignment Type 

Labeling (EU) → Hazard Symbol SAP_EHS_1023_001_SYMBOL SAP_EHS_1023_001 

Labeling (EU) → R Phrases SAP_EHS_1023_001_R_PHRASE SAP_EHS_1023_001 

GHS Labeling (General) → Hazard 

Statements 

SAP_EHS_1023_093_HAZ_STATEMENT SAP_EHS_1023_093 

GHS Labeling (General) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_093_SUPP_HAZ_STAT SAP_EHS_1023_093 

GHS Labeling (EMEA) → Hazard Statements SAP_EHS_1023_094_HAZ_STATEMENT SAP_EHS_1024_093 

GHS Labeling (EMEA) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_094_SUPP_HAZ_STAT SAP_EHS_1024_093 
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8.2.2 Corrosive/Irritant 

 
The predefined condition Corrosive/Irritant checks whether the following characteristics contain phrases that 

indicate corrosive or irritant: 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling (EMEA) 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling 

(General) 

• Hazard Symbol and R Phrases in the value assignment type Labeling (EU). 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

No (GHS EMEA) If the value assignment type GHS Labeling (EMEA) does not contain phrases that 

indicate corrosive or irritant in the characteristics Hazard Statements and Supplem. 

Hazard Statements, the predefined condition applies. 

No (Labeling EU) If the value assignment type Labeling (EU) does not contain phrases that indicate 

corrosive or irritant in the characteristics Hazard Symbol and R Phrases, the 

predefined condition applies. 

No (GHS General) If the value assignment type GHS Labeling (General) does not contain phrases that 

indicate corrosive or irritant in the characteristics Hazard Statements and Supplem. 

Hazard Statements, the predefined condition applies. 

Yes (GHS EMEA) If the value assignment type GHS Labeling (EMEA) contains phrases that indicate 

corrosive or irritant in the characteristics Hazard Statements and Supplem. Hazard 

Statements, the predefined condition applies. 

Yes (Labeling EU) If the value assignment type Labeling (EU) contains phrases that indicate corrosive 

or irritant in the characteristics Hazard Symbol and R Phrases, the predefined 

condition applies. 

Yes (GHS General) If the value assignment type GHS Labeling (General) contains phrases that indicate 

corrosive or irritant in the characteristics Hazard Statements and Supplem. Hazard 

Statements, the predefined condition applies. 

The phrases that indicate corrosive or irritant are considered in the phrase mapping table of the Rule for Safety 

Statements rule set. The phrases to be checked have to be assigned the Internal_id [#FLAGCXI#]. 

If you want to complete phrases that indicate corrosive or irritant, you need to add the assignments in the phrase 

mapping table of the rule set. Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the phrase mapping table ExpPhraseMap. 

3. Add a new entry for the Phrase Set <Phrase Set> with the Internal_id [#FLAGCXI#]. 

4. Assign the phrase key to the External_id field and edit the Phrase Text. 
 

Figure 23 – Phrase Mapping Table in the CoSSta_MSDS.mdb for the Internal_id [#FLAGCXI#] 
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Characteristics used in the predefined condition: 
 

Description Characteristic Value Assignment Type 

Labeling (EU) → Hazard Symbol SAP_EHS_1023_001_SYMBOL SAP_EHS_1023_001 

Labeling (EU) → R Phrases SAP_EHS_1023_001_R_PHRASE SAP_EHS_1023_001 

GHS Labeling (General) → Hazard 

Statements 

SAP_EHS_1023_093_HAZ_STATEMENT SAP_EHS_1023_093 

GHS Labeling (General) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_093_SUPP_HAZ_STAT SAP_EHS_1023_093 

GHS Labeling (EMEA) → Hazard Statements SAP_EHS_1023_094_HAZ_STATEMENT SAP_EHS_1024_093 

GHS Labeling (EMEA) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_094_SUPP_HAZ_STAT SAP_EHS_1024_093 
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8.2.3 Toxic 

 
The predefined condition Toxic checks whether the following characteristics contain phrases that indicate a toxic 

substance: 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling (EMEA) 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling 

(General) 

• Hazard Symbol and R Phrases in the value assignment type Labeling (EU). 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

No (GHS EMEA) If the value assignment type GHS Labeling (EMEA) does not contain phrases 

indicating a toxic substance in the characteristics Hazard Statements and Supplem. 

Hazard Statements, the predefined condition applies. 

No (Labeling EU) If the value assignment type Labeling (EU) does not contain phrases indicating a 

toxic substance in the characteristics Hazard Symbol and R Phrases, the 

predefined condition applies. 

No (GHS General) If the value assignment type GHS Labeling (General) does not contain the phrases 

indicating a toxic substance in the characteristics Hazard Statements and Supplem. 

Hazard Statements, the predefined condition applies. 

Yes (GHS EMEA) If the value assignment type GHS Labeling (EMEA) contains the phrases indicating 

a toxic substance in the characteristics Hazard Statements and Supplem. Hazard 

Statements, the predefined condition applies. 

Yes (Labeling EU) If the value assignment type Labeling (EU) contains the phrases indicating a toxic 

substance in the characteristics Hazard Symbol and R Phrases, the predefined 

condition applies. 

Yes (GHS General) If the value assignment type GHS Labeling (General) contains the phrases 

indicating a toxic substance in the characteristics Hazard Statements and Supplem. 

Hazard Statements, the predefined condition applies. 

The phrases that indicate a toxic substance are considered in the phrase mapping table of the Rule for Safety 

Statements rule set. The phrases to be checked have to be assigned the Internal_id [#FLAGTOXIC#]. 

If you want to complete phrases that indicate a toxic substance, you need to add the assignments in the phrase 

mapping table of the rule set. Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the phrase mapping table ExpPhraseMap. 

3. Add a new entry for the Phrase Set <Phrase Set> with the Internal_id [#FLAGTOXIC#]. 

4. Assign the phrase key to the External_id field and edit the Phrase Text. 
 

Figure 24 - Phrase Mapping Table in the CoSSta_MSDS.mdb for the Internal_id [#FLAGTOXIC#] 



Conditions for Safety Statements 

Appendix 

CUSTOMER 

© 2015 SAP SE or an SAP affiliate company. All rights reserved. 55 

 

 

 
 
 
 

Characteristics used in the predefined condition: 
 

Description Characteristic Value Assignment Type 

Labeling (EU) → Hazard Symbol SAP_EHS_1023_001_SYMBOL SAP_EHS_1023_001 

Labeling (EU) → R Phrases SAP_EHS_1023_001_R_PHRASE SAP_EHS_1023_001 

GHS Labeling (General) → Hazard 

Statements 

SAP_EHS_1023_093_HAZ_STATEMENT SAP_EHS_1023_093 

GHS Labeling (General) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_093_SUPP_HAZ_STAT SAP_EHS_1023_093 

GHS Labeling (EMEA) → Hazard Statements SAP_EHS_1023_094_HAZ_STATEMENT SAP_EHS_1024_093 

GHS Labeling (EMEA) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_094_SUPP_HAZ_STAT SAP_EHS_1024_093 



Conditions for Safety Statements 

Appendix 

CUSTOMER 

© 2015 SAP SE or an SAP affiliate company. All rights reserved. 56 

 

 

 
 
 
 

8.2.4 Specific Toxic 

 
The predefined condition Specific Toxic checks whether the following characteristics contain phrases that 

indicate a specific toxic substance: 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling (EMEA) 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling 

(General) 

• Hazard Symbol and R Phrases in the value assignment type Labeling (EU). 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

No (GHS EMEA) If the value assignment type GHS Labeling (EMEA) does not contain the phrases 

indicating a specific toxic substance in the characteristics Hazard Statements and 

Supplem. Hazard Statements, the predefined condition applies. 

No (Labeling EU) If the value assignment type Labeling (EU) does not contain the phrases indicating a 

specific toxic substance in the characteristics Hazard Symbol and R Phrases, the 

predefined condition applies. 

No (GHS General) If the value assignment type GHS Labeling (General) does not contain the phrases 

indicating a specific toxic substance in the characteristics Hazard Statements and 

Supplem. Hazard Statements, the predefined condition applies. 

Yes (GHS EMEA) If the value assignment type GHS Labeling (EMEA) contains the phrases indicating 

a specific toxic substance in the characteristics Hazard Statements and Supplem. 

Hazard Statements, the predefined condition applies. 

Yes (Labeling EU) If the value assignment type Labeling (EU) contains the phrases indicating a 

specific toxic substance in the characteristics Hazard Symbol and R Phrases, the 

predefined condition applies. 

Yes (GHS General) If the value assignment type GHS Labeling (General) contains the phrases 

indicating a specific toxic substance in the characteristics Hazard Statements and 

Supplem. Hazard Statements, the predefined condition applies. 

The phrases that indicate a specific toxic substance are considered in the phrase mapping table of the Rule for 

Safety Statements rule set. The phrases to be checked have to be assigned the Internal_id 

[#FLAGSPECTOXIC#]. 

If you want to complete phrases that indicate a specific toxic substance, you need to add the assignments in the 

phrase mapping table of the rule set. Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the phrase mapping table ExpPhraseMap. 

3. Add a new entry for the Phrase Set <Phrase Set> with the Internal_id [#FLAGSPECTOXIC#]. 

4. Assign the phrase key to the External_id field and edit the Phrase Text. 
 

Figure 25 - Phrase Mapping Table in the CoSSta_MSDS.mdb for the Internal_id [#FLAGSPECTOXIC #] 
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Characteristics used in the predefined condition: 
 

Description Characteristic Value Assignment Type 

Labeling (EU) → Hazard Symbol SAP_EHS_1023_001_SYMBOL SAP_EHS_1023_001 

Labeling (EU) → R Phrases SAP_EHS_1023_001_R_PHRASE SAP_EHS_1023_001 

GHS Labeling (General) → Hazard 

Statements 

SAP_EHS_1023_093_HAZ_STATEMENT SAP_EHS_1023_093 

GHS Labeling (General) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_093_SUPP_HAZ_STAT SAP_EHS_1023_093 

GHS Labeling (EMEA) → Hazard Statements SAP_EHS_1023_094_HAZ_STATEMENT SAP_EHS_1024_093 

GHS Labeling (EMEA) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_094_SUPP_HAZ_STAT SAP_EHS_1024_093 
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8.2.5 Physical-Chemical Hazard 

 
The predefined condition Physical-Chemical Hazard checks whether the following characteristics contain 

phrases that indicate the substance has a physical-chemical hazard: 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling (EMEA) 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling 

(General) 

• Hazard Symbol and R Phrases in the value assignment type Labeling (EU). 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

No (GHS EMEA) If the value assignment type GHS Labeling (EMEA) does not contain phrases 

indicating the substance has a physical-chemical hazard in the characteristics 

Hazard Statements and Supplem. Hazard Statements, the predefined condition 

applies. 

No (Labeling EU) If the value assignment type Labeling (EU) does not contain phrases indicating the 

substance has a physical-chemical hazard in the characteristics Hazard Symbol 

and R Phrases, the predefined condition applies. 

No (GHS General) If the value assignment type GHS Labeling (General) does not contain phrases 

indicating the substance has a physical-chemical hazard in the characteristics 

Hazard Statements and Supplem. Hazard Statements, the predefined condition 

applies. 

Yes (GHS EMEA) If the value assignment type GHS Labeling (EMEA) contains phrases indicating the 

substance has a physical-chemical hazard in the characteristics Hazard 

Statements and Supplem. Hazard Statements, the predefined condition applies. 

Yes (Labeling EU) If the value assignment type Labeling (EU) contains phrases indicating the 

substance has a physical-chemical hazard in the characteristics Hazard Symbol 

and R Phrases, the predefined condition applies. 

Yes (GHS General) If the value assignment type GHS Labeling (General) contains phrases the 

substance has a physical-chemical hazard in the characteristics Hazard 

Statements and Supplem. Hazard Statements, the predefined condition applies. 

The phrases that indicate the substance has a physical-chemical hazard are considered in the phrase mapping 

table of the Rule for Safety Statements rule set. The phrases to be checked have to be assigned the Internal_id 

[#FLAGPHSCHEM#]. 

If you want to complete phrases that indicate the substance has a physical-chemical hazard, you need to add the 

assignments in the phrase mapping table of the rule set. Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the phrase mapping table ExpPhraseMap. 

3. Add a new entry for the Phrase Set <Phrase Set> with the Internal_id [#FLAGPHSCHEM#]. 

4. Assign the phrase key to the External_id field and edit the Phrase Text. 

Figure 26 - Phrase Mapping Table in the CoSSta_MSDS.mdb for the Internal_id [#FLAGPHSCHEM#] 
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Characteristics used in the predefined condition: 
 

Description Characteristic Value Assignment Type 

Labeling (EU) → Hazard Symbol SAP_EHS_1023_001_SYMBOL SAP_EHS_1023_001 

Labeling (EU) → R Phrases SAP_EHS_1023_001_R_PHRASE SAP_EHS_1023_001 

GHS Labeling (General) → Hazard 

Statements 

SAP_EHS_1023_093_HAZ_STATEMENT SAP_EHS_1023_093 

GHS Labeling (General) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_093_SUPP_HAZ_STAT SAP_EHS_1023_093 

GHS Labeling (EMEA) → Hazard Statements SAP_EHS_1023_094_HAZ_STATEMENT SAP_EHS_1024_093 

GHS Labeling (EMEA) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_094_SUPP_HAZ_STAT SAP_EHS_1024_093 
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8.2.6 Dangerous for the Environment 

 
The predefined condition Dangerous for the Environment checks whether the following characteristics contain 

phrases that indicate the substance is dangerous to the environment: 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling (EMEA) 

• Hazard Statements and Supplem. Hazard Statements in the value assignment type GHS Labeling 

(General) 

• Hazard Symbol and R Phrases in the value assignment type Labeling (EU). 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

No (GHS EMEA) If the value assignment type GHS Labeling (EMEA) does not contain phrases 

indicating the substance is dangerous to the environment in the characteristics 

Hazard Statements and Supplem. Hazard Statements, the predefined condition 

applies. 

No (Labeling EU) If the value assignment type Labeling (EU) does not contain phrases indicating the 

substance is dangerous to the environment in the characteristics Hazard Symbol 

and R Phrases, the predefined condition applies. 

No (GHS General) If the value assignment type GHS Labeling (General) does not contain phrases 

indicating the substance is dangerous to the environment in the characteristics 

Hazard Statements and Supplem. Hazard Statements, the predefined condition 

applies. 

Yes (GHS EMEA) If the value assignment type GHS Labeling (EMEA) contains phrases indicating the 

substance is dangerous to the environment in the characteristics Hazard 

Statements and Supplem. Hazard Statements, the predefined condition applies. 

Yes (Labeling EU) If the value assignment type Labeling (EU) contains phrases indicating the 

substance is dangerous to the environment in the characteristics Hazard Symbol 

and R Phrases, the predefined condition applies. 

Yes (GHS General) If the value assignment type GHS Labeling (General) contains phrases the 

substance is dangerous to the environment in the characteristics Hazard 

Statements and Supplem. Hazard Statements, the predefined condition applies. 

The phrases that indicate the substance is dangerous to the environment are considered in the phrase mapping 

table of the Rule for Safety Statements rule set. The phrases to be checked have to be assigned the Internal_id 

[#FLAGENV#]. 

If you want to complete phrases that indicate substance is dangerous to the environment, you need to add the 

assignments in the phrase mapping table of the rule set. Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the phrase mapping table ExpPhraseMap. 

3. Add a new entry for the Phrase Set <Phrase Set> with the Internal_id [#FLAGENV#]. 

4. Assign the phrase key to the External_id field and edit the Phrase Text. 

Figure 27 - Phrase Mapping Table in the CoSSta_MSDS.mdb for the Internal_id [#FLAGENV#] 
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Characteristics used in the predefined condition: 
 

Description Characteristic Value Assignment Type 

Labeling (EU) → Hazard Symbol SAP_EHS_1023_001_SYMBOL SAP_EHS_1023_001 

Labeling (EU) → R Phrases SAP_EHS_1023_001_R_PHRASE SAP_EHS_1023_001 

GHS Labeling (General) → Hazard 

Statements 

SAP_EHS_1023_093_HAZ_STATEMENT SAP_EHS_1023_093 

GHS Labeling (General) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_093_SUPP_HAZ_STAT SAP_EHS_1023_093 

GHS Labeling (EMEA) → Hazard Statements SAP_EHS_1023_094_HAZ_STATEMENT SAP_EHS_1024_093 

GHS Labeling (EMEA) → Supplem. Hazard 

Statements Effect 

SAP_EHS_1023_094_SUPP_HAZ_STAT SAP_EHS_1024_093 
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8.2.7 Dangerous Goods 

 
The predefined condition Dangerous Goods checks whether the specification is classified as a dangerous good in 

the Transport Classification in the value assignment type Dangerous Goods Classification. 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

No (ADR) If the Risk Potential is not filled and the Non-Dangerous Goods Full Transport is set 

for the Dangerous Goods Regulation ADR, the predefined condition applies. 

No (CFR) If the Risk Potential is not filled and the Non-Dangerous Goods Full Transport is set 

for the Dangerous Goods Regulation CFR, the predefined condition applies. 

No (IATA_C) If the Risk Potential is not filled and the Non-Dangerous Goods Full Transport is set 

for the Dangerous Goods Regulation IATA_C, the predefined condition applies. 

No (IMDG) If the Risk Potential is not filled and the Non-Dangerous Goods Full Transport is set 

for the Dangerous Goods Regulation IMDG, the predefined condition applies. 

Yes (ADR) If the Risk Potential is filled and the Non-Dangerous Goods Full Transport is not set 

for the Dangerous Goods Regulation ADR, the predefined condition applies. 

Yes (CFR) If the Risk Potential is filled and the Non-Dangerous Goods Full Transport is not set 

for the Dangerous Goods Regulation CFR, the predefined condition applies. 

Yes (IATA_C) If the Risk Potential is filled and the Non-Dangerous Goods Full Transport is not set 

for the Dangerous Goods Regulation IATA_C, the predefined condition applies. 

Yes (IMDG) If the Risk Potential is filled and the Non-Dangerous Goods Full Transport is not set 

for the Dangerous Goods Regulation IMDG, the predefined condition applies. 

Value assignment type used in the predefined condition: 
 

Description Value Assignment Type 

Dangerous Goods Classification SAP_EHS_1022_023 
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8.2.8 Dangerous Goods Class 

 
The predefined condition Dangerous Goods Class checks whether the characteristic Dangerous Goods Class 

matches the selected expression in the value assignment type Dangerous Goods Regulations of the referenced 

specification (specification type UN-listed substance). The Dangerous Goods Regulation is not relevant. 

The specification of the specification type UN listed substance is referenced in the Transport Classification in the 

value assignment type Dangerous Goods Classification of the real substance. 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

2 If the characteristic Dangerous Goods Class is equal to 2 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

3 If the characteristic Dangerous Goods Class is equal to 3 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

4.1 If the characteristic Dangerous Goods Class is equal to 4.1 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

4.2 If the characteristic Dangerous Goods Class is equal to 4.2 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

4.3 If the characteristic Dangerous Goods Class is equal to 4.3 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

5.1 If the characteristic Dangerous Goods Class is equal to 5.1 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

5.2 If the characteristic Dangerous Goods Class is equal to 5.2 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

6.1 If the characteristic Dangerous Goods Class is equal to 6.1 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

6.2 If the characteristic Dangerous Goods Class is equal to 6.2 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

8 If the characteristic Dangerous Goods Class is equal to 8 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

9 If the characteristic Dangerous Goods Class is equal to 9 in the value assignment 

type Dangerous Goods Regulations, the predefined condition applies. 

Characteristic used in the predefined condition: 
 

Description Characteristic Value Assignment Type 

Dangerous Goods Regulations → Dangerous 

Goods Class 

SAP_EHS_1022_024_DGCL SAP_EHS_1022_024 
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8.2.9 Standard Composition 

 
The predefined condition Standard Composition checks whether the specification contains more than one 

component in the value assignment type Standard Composition. 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

No If the value assignment type Standard Composition contains only one component or 

does not contain any components, the predefined condition applies. 

Yes If the value assignment type Standard Composition contains at least two 

components, the predefined condition applies. 

If you want to check another composition, you need to change the assignments in the composition mapping table 

of the rule set. Proceed as follows: 

1. Open CoSSta_MSDS.mdb using Microsoft Office Access. 

2. Open the phrase mapping table ExpGroupMap. 

3. Edit the External_id field with the Syntax M:<Value assignment type> for the data record with 

Internal_id <COMP>. 

Figure 28 - Composition Mapping Table in the CoSSta_MSDS.mdb 
 

Value assignment type used in the predefined condition: 
 

Description Value Assignment Type 

Standard Composition SAP_EHS_1012_003 
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8.2.10 Viscosity 

 
The predefined condition Viscosity checks whether the characteristic value matches the selected expression for 

the following characteristics: 

• Value and Temperature in the value assignment type Viscosity, Kinematic 

• Value and Cross-section in the value assignment type Flow Time. 

You can select one of the following values of the predefined condition: 
 

Possible Value Explanation 

< 7 mm2/s (40°C) 

(Kinematic Viscosity) 

If the characteristic Value is less than 7 mm2/s at a Temperature of 40 °C in the 

value assignment type Viscosity, Kinematic, the predefined condition applies. 

<= 20 mm2/s (40°C) 

(Kinematic Viscosity) 

If the characteristic Value is less than or equal to 20 mm2/s at a Temperature of 

40 °C in the value assignment type Viscosity, Kinematic, the predefined condition 

applies. 

<= 20,5 mm2/s (40°C) 

(Kinematic Viscosity) 

If the characteristic Value is less than or equal to 20,5 mm2/s at a Temperature of 

40 °C in the value assignment type Viscosity, Kinematic, the predefined condition 

applies. 

< 30 s (3 mm ISO) 

(Flow Time) 

If the characteristic Value is less than 30 s at a Cross-section of 3 mm in the value 

assignment type Flow Time, the predefined condition applies. 

>= 100 s (6 mm ISO) 

(Flow Time) 

If the characteristic Value is greater than or equal to 100 s at a Cross-section of 

6 mm in the value assignment type Flow Time, the predefined condition applies. 

>= 20 s (4 mm ISO) 

(Flow Time) 

If the characteristic Value is greater than or equal to 20 s at a Cross-section of 

4 mm in the value assignment type Flow Time, the predefined condition applies. 

>= 40 s (6 mm ISO) 

(Flow Time) 

If the characteristic Value is greater than or equal to 40 s at a Cross-section of 

6 mm in the value assignment type Flow Time, the predefined condition applies. 

>= 60 s (4 mm ISO) 

(Flow Time) 

If the characteristic Value is greater than or equal to 60 s at a Cross-section of 

4 mm in the value assignment type Flow Time, the predefined condition applies. 

>= 60 s (6 mm ISO) 

(Flow Time) 

If the characteristic Value is greater than or equal to 60 s at a Cross-section of 

6 mm in the value assignment type Flow Time, the predefined condition applies. 

Characteristics used in the predefined condition: 
 

Description Characteristic Value Assignment Type 

Viscosity, Kinematic → Value SAP_EHS_1013_028_VALUE SAP_EHS_1013_028 

Viscosity, Kinematic → Temperature SAP_EHS_1013_028_EC_TEMP SAP_EHS_1013_028 

Flow Time → Value SAP_EHS_1013_002_VALUE SAP_EHS_1013_002 

Flow Time → Cross-section SAP_EHS_1013_002_EC_AREA SAP_EHS_1013_002 
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8.3 Supported Characteristics 

 

8.3.1 Supported Conclusive Characteristics 
 
 

Description Characteristic Value Assignment Type 

Possible Hazards (Summary) → Advice SAP_EHS_1011_001_ADVICE SAP_EHS_1011_001 

Possible Hazards (Summary) → Chronic 

Exposure 

SAP_EHS_1011_001_CHRONIC SAP_EHS_1011_001 

Possible Hazards (Summary) → Primary 

Routes of Entry 

SAP_EHS_1011_001_ENTRY SAP_EHS_1011_001 

Possible Hazards (Summary) → Potential 

Environmental Effect 

SAP_EHS_1011_001_ENVIRON SAP_EHS_1011_001 

Possible Hazards (Summary) →Eyes SAP_EHS_1011_001_EYE SAP_EHS_1011_001 

Possible Hazards (Summary) → Ingestion SAP_EHS_1011_001_INGEST SAP_EHS_1011_001 

Possible Hazards (Summary) → Inhalation SAP_EHS_1011_001_INHALE SAP_EHS_1011_001 

Possible Hazards (Summary) → Aggravated 

Medical Condition 

SAP_EHS_1011_001_MEDICAL SAP_EHS_1011_001 

Possible Hazards (Summary) → Target 

Organs 

SAP_EHS_1011_001_ORGANS SAP_EHS_1011_001 

Possible Hazards (Summary) → 

Physical/Chemical Hazards 

SAP_EHS_1011_001_PHYS_CHEM SAP_EHS_1011_001 

Possible Hazards (Summary) → Remarks SAP_EHS_1011_001_REMARK SAP_EHS_1011_001 

Possible Hazards (Summary) → Signal Word SAP_EHS_1011_001_SIGNAL_WORD SAP_EHS_1011_001 

Possible Hazards (Summary) → Skin SAP_EHS_1011_001_SKIN SAP_EHS_1011_001 

Other Information → Other Information SAP_EHS_1011_002_INFO SAP_EHS_1011_002 

Other Information → Sources of Key Data SAP_EHS_1011_002_SOURCE SAP_EHS_1011_002 

Other Hazards (GHS) → Other Hazards SAP_EHS_1011_011_OTHER_HAZ SAP_EHS_1011_011 

Hazardous Reactions → Further Info on 

Stability 

SAP_EHS_1014_019_STAB_FURTHER SAP_EHS_1014_019 

Hazardous Reactions → Hazardous 

Reactions 

SAP_EHS_1014_019_VALUE SAP_EHS_1014_019 

Decomposition Products → Info on 

Hazardous Dec. Prod. 

SAP_EHS_1014_020_INFO SAP_EHS_1014_020 
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Description Characteristic Value Assignment Type 

Thermal Decomposition → Remarks SAP_EHS_1014_021_REMARK SAP_EHS_1014_021 

Dust Explosion Class → Dust Explosion Class 

St1 - St3 

SAP_EHS_1014_023_CLASS_VALUE SAP_EHS_1014_023 

Temperature Class → Class SAP_EHS_1014_025_VALUE SAP_EHS_1014_025 

Classification of Fires → Class SAP_EHS_1014_027_VALUE SAP_EHS_1014_027 

Conditions to Avoid (SDS) → Remarks SAP_EHS_1014_030_REMARK SAP_EHS_1014_030 

Substances to Avoid (SDS) → Remarks SAP_EHS_1014_031_REMARK SAP_EHS_1014_031 

Reactivity → Advice SAP_EHS_1014_033_ADVICE SAP_EHS_1014_033 

Chemical Stability → Advice SAP_EHS_1014_034_ADVICE SAP_EHS_1014_034 

First Aid: General Information → Advice SAP_EHS_1015_002_ADVICE SAP_EHS_1015_002 

First Aid: Eye → Advice SAP_EHS_1015_003_ADVICE SAP_EHS_1015_003 

First Aid: Skin → Advice SAP_EHS_1015_004_ADVICE SAP_EHS_1015_004 

First Aid: Ingestion → Advice SAP_EHS_1015_005_ADVICE SAP_EHS_1015_005 

First Aid: Inhalation → Advice SAP_EHS_1015_006_ADVICE SAP_EHS_1015_006 

Hints for Physician → Hazards SAP_EHS_1015_012_HAZARDS SAP_EHS_1015_012 

Hints for Physician → Symptoms SAP_EHS_1015_012_SYMPTOMS SAP_EHS_1015_012 

Hints for Physician → Treatment SAP_EHS_1015_012_TREATMENT SAP_EHS_1015_012 

Protection of First Aid Responders → Advice SAP_EHS_1015_013_ADVICE SAP_EHS_1015_013 

Protection of First Aid Responders → 

Remarks 

SAP_EHS_1015_013_REMARKS SAP_EHS_1015_013 

Extinguishing Media → Unsuitable SAP_EHS_1016_001_NO SAP_EHS_1016_001 

Extinguishing Media → Suitable SAP_EHS_1016_001_YES SAP_EHS_1016_001 

Hazards During Fire-Fighting → Advice SAP_EHS_1016_002_ADVICE SAP_EHS_1016_002 

Protective Equipment for Fire-Fighting → 

Advice 

SAP_EHS_1016_003_ADVICE SAP_EHS_1016_003 

Fire-Fighting/Further Advice → Further 

Advice 

SAP_EHS_1016_004_ADVICE SAP_EHS_1016_004 

Fire-Fighting/Further Advice → Specific 

Extinguishing Methods 

SAP_EHS_1016_004_SPEM SAP_EHS_1016_004 

Personal Precautions → Advice SAP_EHS_1016_005_ADVICE SAP_EHS_1016_005 
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Description Characteristic Value Assignment Type 

Environmental Precautions → Advice: 

General 

SAP_EHS_1016_006_ADVICE SAP_EHS_1016_006 

Environmental Precautions → Advice: Air SAP_EHS_1016_006_ADVICE_AIR SAP_EHS_1016_006 

Environmental Precautions → Advice: Soil SAP_EHS_1016_006_ADVICE_SOIL SAP_EHS_1016_006 

Environmental Precautions → Advice: Water SAP_EHS_1016_006_ADVICE_WATER SAP_EHS_1016_006 

Methods for Cleaning or Taking Up → Advice SAP_EHS_1016_007_ADVICE SAP_EHS_1016_007 

Further Accidental Release Measures → 

Advice 

SAP_EHS_1016_008_ADVICE SAP_EHS_1016_008 

Fire and Explosion Protection → Fire and 

Explosion Protection 

SAP_EHS_1016_009_REMARK SAP_EHS_1016_009 

Advice on System Design → Advice SAP_EHS_1016_010_ADVICE SAP_EHS_1016_010 

Industrial Hygiene → Advice SAP_EHS_1016_011_ADVICE SAP_EHS_1016_011 

Respiratory Protection → Advice SAP_EHS_1016_012_ADVICE SAP_EHS_1016_012 

Respiratory Protection → Filter Type SAP_EHS_1016_012_TYPE SAP_EHS_1016_012 

Hand Protection → Additional Protection SAP_EHS_1016_013_ADVICE SAP_EHS_1016_013 

Hand Protection → Glove Length SAP_EHS_1016_013_GLOVELEN SAP_EHS_1016_013 

Hand Protection → Guideline SAP_EHS_1016_013_GUIDELINE SAP_EHS_1016_013 

Hand Protection → Material SAP_EHS_1016_013_MATERIAL SAP_EHS_1016_013 

Hand Protection → Manufacturer SAP_EHS_1016_013_PRODUCER SAP_EHS_1016_013 

Hand Protection → Protection Index SAP_EHS_1016_013_PROTINDEX SAP_EHS_1016_013 

Eye Protection → Advice SAP_EHS_1016_014_ADVICE SAP_EHS_1016_014 

Body Protection → Advice SAP_EHS_1016_015_ADVICE SAP_EHS_1016_015 

General Protective Measures → Personal 

Protective Equipment 

SAP_EHS_1016_016_ADVICE SAP_EHS_1016_016 

Advice on Safe Handling → Advice SAP_EHS_1016_017_ADVICE SAP_EHS_1016_017 

Reference to Other Sections → Advice SAP_EHS_1016_023_ADVICE SAP_EHS_1016_023 

Technical Measures (Handling) → Advice SAP_EHS_1016_024_ADVICE SAP_EHS_1016_024 

Technical Measures (Handling) → Remarks SAP_EHS_1016_024_REMARK SAP_EHS_1016_024 

Technical Measures (Handling) → 

Local/Total Ventilation 

SAP_EHS_1016_024_VENT SAP_EHS_1016_024 
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Description Characteristic Value Assignment Type 

Biodegradation → Remarks SAP_EHS_1017_004_REMARK SAP_EHS_1017_004 

Physico-Chemical Elimination → Remarks SAP_EHS_1017_005_REMARK SAP_EHS_1017_005 

Biological Oxygen Demand (BOD) → 

Remarks 

SAP_EHS_1017_007_REMARK SAP_EHS_1017_007 

Chemical Oxygen Demand (COD) → Remarks SAP_EHS_1017_008_REMARK SAP_EHS_1017_008 

Dissolved Organic Carbon (DOC) → Remarks SAP_EHS_1017_012_REMARK SAP_EHS_1017_012 

Bioaccumulation → Remarks SAP_EHS_1017_015_REMARK SAP_EHS_1017_015 

Adsorption Organ. Bound Halogen (AOX) → 

Remarks 

SAP_EHS_1017_020_REMARK SAP_EHS_1017_020 

Acute and Prolonged Toxicity to Fish → 

Remarks 

SAP_EHS_1018_001_REMARK SAP_EHS_1018_001 

Toxicity to Aquatic Plants → Remarks SAP_EHS_1018_003_REMARK SAP_EHS_1018_003 

Toxicity to Microorganisms → Remarks SAP_EHS_1018_004_REMARK SAP_EHS_1018_004 

Additional Ecotoxicological Remarks → 

Remarks 

SAP_EHS_1018_012_REMARK SAP_EHS_1018_012 

Acute Oral Toxicity → Remarks SAP_EHS_1019_001_REMARK SAP_EHS_1019_001 

Acute Oral Toxicity → Symptoms SAP_EHS_1019_001_SYMPTOM SAP_EHS_1019_001 

Acute Inhalation Toxicity → Remarks SAP_EHS_1019_002_REMARK SAP_EHS_1019_002 

Acute Inhalation Toxicity → Symptoms SAP_EHS_1019_002_SYMPTOM SAP_EHS_1019_002 

Acute Dermal Toxicity → Remarks SAP_EHS_1019_003_REMARK SAP_EHS_1019_003 

Acute Dermal Toxicity → Symptoms SAP_EHS_1019_003_SYMPTOM SAP_EHS_1019_003 

Acute Toxicity Other Routes → Remarks SAP_EHS_1019_004_REMARK SAP_EHS_1019_004 

Acute Toxicity Other Routes → Symptoms SAP_EHS_1019_004_SYMPTOM SAP_EHS_1019_004 

Skin Irritation → Remarks SAP_EHS_1019_005_REMARK SAP_EHS_1019_005 

Eye Irritation → Remarks SAP_EHS_1019_006_REMARK SAP_EHS_1019_006 

Sensitization → Remarks SAP_EHS_1019_007_REMARK SAP_EHS_1019_007 

Other Relevant Toxicity Information → 

Remarks 

SAP_EHS_1019_017_REMARK SAP_EHS_1019_017 

Aspiration Toxicity Hazard → Statement on 

Aspiration Tox. 

SAP_EHS_1019_027_COMMENT SAP_EHS_1019_027 

Storage Stability → Storage Moisture SAP_EHS_1021_001_MOISTURE SAP_EHS_1021_001 
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Description Characteristic Value Assignment Type 

Storage Stability → Remarks SAP_EHS_1021_001_REMARK SAP_EHS_1021_001 

Mixed Storage → Advice on Storage 

Compatib. 

SAP_EHS_1021_002_ADVICE SAP_EHS_1021_002 

Storage Conditions → More Info on Storage 

Condit. 

SAP_EHS_1021_003_INFO SAP_EHS_1021_003 

Storage Class → Storage Class SAP_EHS_1021_004_CLASS SAP_EHS_1021_004 

Storage Requirements (SDS) → Advice SAP_EHS_1021_006_ADV SAP_EHS_1021_006 

Safe Packaging Materials (Storage) → 

Remarks 

SAP_EHS_1021_007_REMARK SAP_EHS_1021_007 

Safe Packaging Materials (Storage) → 

Suitable Materials 

SAP_EHS_1021_007_SUITABLE SAP_EHS_1021_007 

Safe Packaging Materials (Storage) → 

Unsuitable Materials 

SAP_EHS_1021_007_UNSUITABLE SAP_EHS_1021_007 

Further Information for Transport (SDS) → 

Remarks 

SAP_EHS_1022_021_REMARK SAP_EHS_1022_021 

Add. Comments Classific./Labeling (EU) → 

Add. Comments Class./Label. 

SAP_EHS_1023_005_COMMENT SAP_EHS_1023_005 

Advice on Disposal and Packaging → Advice 

on Disposal 

SAP_EHS_1023_018_ADVICE SAP_EHS_1023_018 

Waste Disposal of Packages Not Cleaned → 

Advice 

SAP_EHS_1023_019_ADVICE SAP_EHS_1023_019 

Information About Other Regulations → 

Other Regulations (SDS) 

SAP_EHS_1023_020_TEXT SAP_EHS_1023_020 

REACH Chemical Safety Assessment → 

Chemical Safety Assessment 

SAP_EHS_1023_083_CSA SAP_EHS_1023_083 
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8.3.2 Supported Condition Parameter Characteristics 
 
 

Description Characteristic Value Assignment Type 

Control Data for Rule Sets → Value SAP_EHS_0101_003_VALUE SAP_EHS_0101_003 

Type of Substance → Mixture or Pure 

Substance? 

SAP_EHS_1011_005_MIXT_PURE SAP_EHS_1011_005 

Type of Substance → Type of Substance SAP_EHS_1011_005_TYPE SAP_EHS_1011_005 

Use of Substance/Preparation → Specific 

Use 

SAP_EHS_1011_010_SPEC_USE SAP_EHS_1011_010 

Other Hazards (GHS) → Other Hazards SAP_EHS_1011_011_OTHER_HAZ SAP_EHS_1011_011 

Hazardous Ingredients → Remarks SAP_EHS_1012_004_REMARK SAP_EHS_1012_004 

Chemical Characterization → Chemical 

Characterization 

SAP_EHS_1012_015_REMARK SAP_EHS_1012_015 

Special Ingredients → Value Type SAP_EHS_1012_019_VALUE_TYPE SAP_EHS_1012_019 

State of Matter → State of Matter SAP_EHS_1013_001_VALUE SAP_EHS_1013_001 

Vapor Pressure → Value SAP_EHS_1013_003_VALUE SAP_EHS_1013_003 

Form → Form SAP_EHS_1013_009_VALUE SAP_EHS_1013_009 

Solubility in Water → Remarks SAP_EHS_1013_016_REMARK SAP_EHS_1013_016 

pH → pH Value SAP_EHS_1013_019_VALUE SAP_EHS_1013_019 

Phase Transition Liquid/Gas → Value SAP_EHS_1013_022_VALUE SAP_EHS_1013_022 

Conductance → Value SAP_EHS_1013_052_VALUE SAP_EHS_1013_052 

Flammability → Result Gases/Solids SAP_EHS_1014_007_VALUE SAP_EHS_1014_007 

Flammability → Result Liquids SAP_EHS_1014_007_VALUE_LIQ SAP_EHS_1014_007 

Flash Point → Value SAP_EHS_1014_009_VALUE SAP_EHS_1014_009 

Storage Stability → Storage Temperature SAP_EHS_1021_001_TEMP SAP_EHS_1021_001 

Storage class → Storage Class SAP_EHS_1021_004_CLASS SAP_EHS_1021_004 

Labeling (EU) → R Phrases SAP_EHS_1023_001_R_PHRASE SAP_EHS_1023_001 

Labeling (EU) → S Phrases SAP_EHS_1023_001_S_PHRASE SAP_EHS_1023_001 

Labeling (EU) → Hazard Symbol SAP_EHS_1023_001_SYMBOL SAP_EHS_1023_001 

Labeling of Special Preparations (EU) → 

Special Labeling 

SAP_EHS_1023_002_LABELLING SAP_EHS_1023_002 
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Description Characteristic Value Assignment Type 

Water Pollution (DE) → Water Pollution 

Class 

SAP_EHS_1023_009_HAZARD_CLASS SAP_EHS_1023_009 

OSHA Hazard Classification (US) → OSHA 

Hazard Category 

SAP_EHS_1023_037_VALUE SAP_EHS_1023_037 

WHMIS Classification (CA) → Class SAP_EHS_1023_038_CLASS SAP_EHS_1023_038 

WHMIS Classification (CA) → Remarks SAP_EHS_1023_038_REMARK SAP_EHS_1023_038 

TSCA Lists (US) →Requirements SAP_EHS_1023_053_TSCA_REQ SAP_EHS_1023_053 

GHS Labeling (General) → Hazard 

Statements 

SAP_EHS_1023_093_HAZ_STATEMENT SAP_EHS_1023_093 

GHS Labeling (General) → Prec. 

Statements: Disposal 

SAP_EHS_1023_093_PRE_STA_DISP SAP_EHS_1023_093 

GHS Labeling (General) → Prec. 

Statements: Prevention 

SAP_EHS_1023_093_PRE_STA_PREV SAP_EHS_1023_093 

GHS Labeling (General) → Prec. 

Statements: Response 

SAP_EHS_1023_093_PRE_STA_RESP SAP_EHS_1023_093 

GHS Labeling (General) → Prec. 

Statements: General 

SAP_EHS_1023_093_PRE_STATEMENT SAP_EHS_1023_093 

GHS Labeling (General) → Prec. 

Statements: Storage 

SAP_EHS_1023_093_PRE_STA_STOR SAP_EHS_1023_093 

GHS Labeling (General) → Signal Word SAP_EHS_1023_093_SIGNAL SAP_EHS_1023_093 

GHS Labeling (General) → Supplem. 

Hazard Statements 

SAP_EHS_1023_093_SUPP_HAZ_STAT SAP_EHS_1023_093 

GHS Labeling (General) → Symbols SAP_EHS_1023_093_SYMBOL SAP_EHS_1023_093 

GHS Labeling (EMEA) → Hazard 

Statements 

SAP_EHS_1023_094_HAZ_STATEMENT SAP_EHS_1023_094 

GHS Labeling (EMEA) → Prec. Statements: 

Disposal 

SAP_EHS_1023_094_PRE_STA_DISP SAP_EHS_1023_094 

GHS Labeling (EMEA) → Prec. Statements: 

Prevention 

SAP_EHS_1023_094_PRE_STA_PREV SAP_EHS_1023_094 

GHS Labeling (EMEA) → Prec. Statements: 

Response 

SAP_EHS_1023_094_PRE_STA_RESP SAP_EHS_1023_094 

GHS Labeling (EMEA) → Prec. Statements: 

General 

SAP_EHS_1023_094_PRE_STATEMENT SAP_EHS_1023_094 
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Description Characteristic Value Assignment Type 

GHS Labeling (EMEA) → Prec. Statements: 

Storage 

SAP_EHS_1023_094_PRE_STA_STOR SAP_EHS_1023_094 

GHS Labeling (EMEA) → Signal Word SAP_EHS_1023_094_SIGNAL SAP_EHS_1023_094 

GHS Labeling (EMEA) → Supplem. Hazard 

Statements 

SAP_EHS_1023_094_SUPP_HAZ_STAT SAP_EHS_1023_094 

GHS Labeling (EMEA) → Symbols SAP_EHS_1023_094_SYMBOL SAP_EHS_1023_094 

GHS Labeling (NA) → Hazard Statements SAP_EHS_1023_095_HAZ_STATEMENT SAP_EHS_1023_095 

GHS Labeling (NA) → Prec. Statements: 

Disposal 

SAP_EHS_1023_095_PRE_STA_DISP SAP_EHS_1023_095 

GHS Labeling (NA) → Prec. Statements: 

Prevention 

SAP_EHS_1023_095_PRE_STA_PREV SAP_EHS_1023_095 

GHS Labeling (NA) → Prec. Statements: 

Response 

SAP_EHS_1023_095_PRE_STA_RESP SAP_EHS_1023_095 

GHS Labeling (NA) → Prec. Statements: 

General 

SAP_EHS_1023_095_PRE_STATEMENT SAP_EHS_1023_095 

GHS Labeling (NA) → Prec. Statements: 

Storage 

SAP_EHS_1023_095_PRE_STA_STOR SAP_EHS_1023_095 

GHS Labeling (NA) → Signal Word SAP_EHS_1023_095_SIGNAL SAP_EHS_1023_095 

GHS Labeling (NA) → Supplem. Hazard 

Statements 

SAP_EHS_1023_095_SUPP_HAZ_STAT SAP_EHS_1023_095 

GHS Labeling (NA) → Symbols SAP_EHS_1023_095_SYMBOL SAP_EHS_1023_095 

GHS Labeling (A/P) → Hazard Statements SAP_EHS_1023_096_HAZ_STATEMENT SAP_EHS_1023_096 

GHS Labeling (A/P) → Prec. Statements: 

Disposal 

SAP_EHS_1023_096_PRE_STA_DISP SAP_EHS_1023_096 

GHS Labeling (A/P) → Prec. Statements: 

Prevention 

SAP_EHS_1023_096_PRE_STA_PREV SAP_EHS_1023_096 

GHS Labeling (A/P) → Prec. Statements: 

Response 

SAP_EHS_1023_096_PRE_STA_RESP SAP_EHS_1023_096 

GHS Labeling (A/P) → Prec. Statements: 

General 

SAP_EHS_1023_096_PRE_STATEMENT SAP_EHS_1023_096 

GHS Labeling (A/P) → Prec. Statements: 

Storage 

SAP_EHS_1023_096_PRE_STA_STOR SAP_EHS_1023_096 

GHS Labeling (A/P) → Signal Word SAP_EHS_1023_096_SIGNAL SAP_EHS_1023_096 
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Description Characteristic Value Assignment Type 

GHS Labeling (A/P) → Supplem. Hazard 

Statements 

SAP_EHS_1023_096_SUPP_HAZ_STAT SAP_EHS_1023_096 

GHS Labeling (A/P) → Symbols SAP_EHS_1023_096_SYMBOL SAP_EHS_1023_096 

GHS Labeling (LA) → Hazard Statements SAP_EHS_1023_097_HAZ_STATEMENT SAP_EHS_1023_097 

GHS Labeling (LA) → Prec. Statements: 

Disposal 

SAP_EHS_1023_097_PRE_STA_DISP SAP_EHS_1023_097 

GHS Labeling (LA) → Prec. Statements: 

Prevention 

SAP_EHS_1023_097_PRE_STA_PREV SAP_EHS_1023_097 

GHS Labeling (LA) → Prec. Statements: 

Response 

SAP_EHS_1023_097_PRE_STA_RESP SAP_EHS_1023_097 

GHS Labeling (LA) → Prec. Statements: 

General 

SAP_EHS_1023_097_PRE_STATEMENT SAP_EHS_1023_097 

GHS Labeling (LA) → Prec. Statements: 

Storage 

SAP_EHS_1023_097_PRE_STA_STOR SAP_EHS_1023_097 

GHS Labeling (LA) → Signal Word SAP_EHS_1023_097_SIGNAL SAP_EHS_1023_097 

GHS Labeling (LA) → Supplem. Hazard 

Statements 

SAP_EHS_1023_097_SUPP_HAZ_STAT SAP_EHS_1023_097 

GHS Labeling (LA) → Symbols SAP_EHS_1023_097_SYMBOL SAP_EHS_1023_097 
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8.4 Database Structure 

 
In this chapter, all database tables are shown with their individual attributes. 

 
 
 

8.4.1 CoSSta 

 
• CUST_SPECIFIC_CHARS 

Used for the definition of customer-specific characteristics. 
 

Attribute Name Description 

ID Primary key 

INTERNAL_ID Internal key used in the rule set 

ESTCAT Value assignment type 

CHAR_KEY Characteristic key 

CONCLUSION_CHAR Is the customer-specific characteristic a conclusive characteristic? 

 

• FACT_CHARS 

Used for the definition of facts. 

Attribute Name Description 

ID Primary key 

FACT_ID Internal key used in the rule set 

ESTCAT Value assignment type 

CHAR_KEY Characteristic key 

 

• IDENTS 

Used for the definition of identifiers as facts. 

Attribute Name Description 

ID Primary key 

INTERNAL_ID Internal key used in the rule set 

CATEGORY Identification category 

TYPE Identification type 
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• INTERFACE_TAB 

Used for the definition of conditions and for the communication with the Rule for Safety Statements. 

Attribute Name Description 

ID_COL Primary key 

RULE_ID_COL Condition ID 

CATEGORY_COL Conclusive characteristic 

OUTPUT_COL Conclusive phrase 

PHRASE_SORT_COL Sort sequence 

PHRASE_CATEGORY_COL Combination of group and weight of importance 

VALIDITYAREAMSDS_COL Usage and own instance indicator 

ALWAYS_COL Always Execute indicator 

OR_COL Facts with the logical operator OR 

AND_COL Facts with the logical operator AND 

NOT_COL Facts with the logical operator NOT 

 

• PDR_VALUE_SET 

Used for the definition of the value set for predefined conditions. 

Attribute Name Description 

ID Primary key 

ID_RULE Foreign key for the predefined condition 

PDR_VALUE Supported value 

DESCRIPTION Value description 

 

• PHRASE_SET 

Used for the definition of phrase sets and the definition of additional values of phrases. 

Attribute Name Description 

ID Primary key 

CHAR_KEY Characteristic key 

ESTCAT Value assignment type 

PHRASE_KEY Phrase key 

SORT_SEQUENCE Order of the written phrases 

GROUP Group used for prioritization 

PRIORITY Weight of importance 

ALWAYS Phrase is always written 

HIDE Phrase is not visible in phrase sets 
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• PHRASES 

Used for the definition of phrases. 

Attribute Name Description 

ID Primary key 

PHRASE_KEY Phrase key 

PHRASE_CODE Phrase code 

PHRASE_Text Phrase text 

 

• PREDEF_RULES 

Used for the definition of predefined conditions. 

Attribute Name Description 

ID Primary key 

INTERNAL_ID Internal representation of the condition 

DESCRIPTION Short description of the condition 

LONG_TEXT Long description of the condition 

 

• PROPERTY_TREE 

Used for the definition of the property tree used in CoSSta. 

Attribute Name Description 

ID Primary key 

ID_PARENT Foreign key for the parent in the property tree 

DESCRIPTION Description of the entry in the property tree 

ESTCAT Value assignment type 

CHAR_KEY Characteristic key 

PHRASED_IND Is the characteristic phrase-enabled? 

UOM Unit of measure for numeric characteristics 

LOWER_LIMIT Lower limit for numeric characteristics 

UPPER_LIMIT Upper limit for numeric characteristics 

NOT_ASSIGNED_CHA 

R 

Is the characteristic unknown? 

 

• SUPPORTED_CHARS 

Used for the definition of all supported conclusive characteristics. 

Attribute Name Description 

ID Primary key 

CHAR_KEY Characteristic key 

ESTCAT Value assignment type 
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• USAGES 

Used for the definition of usages in CoSSta. 

Attribute Name Description 

ID Primary key 

INTERNAL_ID Name of the usage profile 

RATING Rating 

VALIDITY_AREA Validity area 

ACTIVE_FLAG Is the usage active? 

EXCLUDE_FLAG Is the usage excluded? 

 
 
 

8.4.2 MSDSMaker 

 
Only the tables used for the migration are listed in this chapter. The MSDSMaker database has more tables. 

However, these are not relevant. For this reason, they are not explained. 

 
• INTERFACE_TAB 

Attribute Name Description 

ID_COL Primary key 

RULE_ID_COL Condition ID 

CATEGORY_COL Conclusive characteristic 

OUTPUT_COL Conclusive phrase 

PHRASE_SORT_COL Sort sequence 

PHRASE_CATEGORY_COL Combination of group and weight of importance 

VALIDITYAREAMSDS_COL Usage and own instance indicator 

ALWAYS_COL Always execute indicator 

OR_COL Facts with the logical operator OR 

AND_COL Facts with the logical operator AND 

NOT_COL Facts with the logical operator NOT 

 

• LIST_OF_VALUES_TAB 

Attribute Name Description 

ID_COL Primary key 

CLASS_COL Value assignment type 

PROPERTY_COL Characteristic key 

PHRASE_KEY_COL Phrase key 

PHRASE_CODE_COL Phrase code 

PHRASE_LANG_COL Phrase language 
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Attribute Name Description 

PHRASE_GRAPHIC_CO 

L 

Phrase graphic 

PHRASE_COL Phrase text 

PHRASE_SORT Sort index 

PHRASE_CATEGORY Danger category 

 

• MASTER_DATA_TAB 

Attribute Name Description 

ID_COL Primary key 

TYPE_COL Reference or MSDS chapter rule 

POS 
 

FLAG 
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